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Introduction
This guide describes how to install and configure Siebel Universal Queuing for use 
with your Siebel applications.

This book will be useful primarily to people whose title or job description matches 
one of the following: 

The book is organized to present information in a sequence corresponding to the 
order in which you are likely to install and configure Siebel Universal Queuing. The 
book contains:

■ Overview information, including an introduction to the terminology and 
elements used by Siebel Universal Queuing

■ Installation instructions, including failover and troubleshooting information

Call Center 
Administrators

Persons responsible for setting up and maintaining a call center. 
Duties include designing and managing Computer Telephony 
Integration (CTI), SmartScripts, and message broadcasts.

Communications 
Developers

Persons who may integrate a third party universal queuing engine 
for use with Siebel applications using the Siebel Universal 
Queuing application programming interface.

Database 
Administrators

Persons who administer the database system, including data 
loading; system monitoring, backup, and recovery; space 
allocation and sizing; and user account management.

Siebel Application 
Administrators

Persons responsible for planning, setting up, and maintaining 
Siebel applications.

Siebel Application 
Developers 

Persons who plan, implement, and configure Siebel applications, 
possibly adding new functionality.

Siebel System 
Administrators

Persons responsible for the whole system, including installing, 
maintaining, and upgrading Siebel applications. 
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Revision History
■ Configuration instructions for setting up the Siebel Universal Queuing routing 
engine

NOTE: End users are not expected to use this book, although some information 
presented here may be useful to them.

■ Configuration information to set up routes, route properties, escalations, and 
employee sessions

■ End user information about requesting and transferring work items and viewing 
statistics

■ Information about business service methods for interfacing with the routing 
engine

Revision History
Siebel Universal Queuing Administration Guide, Version 7.5
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Overview of Siebel Universal Queuing 1
This chapter provides an overview of Siebel Universal Queuing, including the 
following:

■ An overview of Siebel Universal Queuing and some communications business 
scenarios

■ A description of the Siebel Universal Queuing architecture and its elements

■ A description of how Siebel Universal Queuing works with Siebel Server and the 
Siebel EAI Object Manager and Siebel Communications Server components
Version 7.5 Siebel Universal Queuing Administration Guide 9
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Communications Business Scenarios
In today’s emerging technological and information world, companies are moving 
towards managing and interacting with their customers through a wide variety of 
communications channels, such as voice, email, and fax requests. 

With so many communication channels, companies are faced with managing each 
customer interaction while meeting service levels and maximizing customer 
satisfaction. In addition, customers are faced with optimally staffing and training 
their workforce to deal with these communication channels whether through their 
call center, telebusiness organizations, or their sales, marketing, and service 
professionals.

Currently, many customers have dedicated email and fax addresses defined for 
specific business areas, as well as automated call distributors. Employees are 
assigned to poll and manage the inquiries for each communication channel. 
Combined with the traditional call queues for inbound voice calls, agents are tasked 
with managing many of these communication channels, yet they may not have any 
visibility to the queue status and priorities of each channel.

A universal queuing strategy can maximize productivity and customer satisfaction 
through every communications channel by assigning, routing, and queuing work 
items from many channels across a common group of blended agents. This reduces 
response times and customer hold times, while balancing priorities among multiple 
communication channels. Customers receive the best possible attention in the least 
amount of time.

The communications toolbar in the Siebel application allows agents to receive and 
manage work items from any of these channels. Siebel Universal Queuing, a 
licensed module that is new for Siebel 7, interacts with different Siebel Server 
components, such as Siebel Communications Server, to manage the many types of 
communication channels with the customer and proactively present them to the 
employee in a timely and structured manner.

In the following scenarios, Siebel Universal Queuing examines the type of the 
request, determines the correct handling of the request based on communication 
channel type and routing rules, and forwards the request to the appropriate call 
center agent for handling.
10 Siebel Universal Queuing Administration Guide Version 7.5
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Routing Voice Calls
A customer sees an ad for a product and dials the toll-free number associated with 
the ad. The customer call is routed into a call queue. The call is forwarded to Siebel 
Universal Queuing for routing to the most qualified available agent. Siebel Universal 
Queuing uses the toll-free number or other selection made by the customer to 
determine the routing rule to use.

Routing Email Requests
A customer is looking at the Web site of the company and decides to email a 
question about a service to a particular mailto link on the Web site. The customer’s 
email program is opened and a new email message appears already addressed to 
the company. The customer types in the question and clicks the send button. 

The company’s email server receives the email and forwards it to Siebel Universal 
Queuing for routing to the most qualified agent for further processing. An agent 
uses Siebel eMail Response features to read and reply to the email message.

Routing Incoming Faxes
A customer receives a renewal flyer for their subscription of a service offered by the 
company. The customer completes the flyer and faxes it back to the company for 
processing. The company’s fax server receives the fax and forwards it to Siebel 
Universal Queuing for routing through the appropriate Siebel communications 
infrastructure components to the most qualified agent for further processing.
Version 7.5 Siebel Universal Queuing Administration Guide 11
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About Siebel Universal Queuing
Siebel Universal Queuing is a business solution that assists you in routing the 
communications customers use to interact with your company. Typical 
communications channels are voice calls or email.

Siebel Universal Queuing routes incoming communications to the most 
appropriately skilled call center agent. Siebel Universal Queuing also determines 
agent availability, which is key to routing communications so they will be handled 
in a timely manner. 

To determine the best available agent, Siebel Universal Queuing applies routing 
rules that you define. To define such a rule, you determine:

■ The communications channel to which a rule applies (voice, email, fax, and so 
on)

■ The specific properties for each communication that will be matched to the 
routing rule

■ The skills (language, product area, and so on) that an agent must possess to 
appropriately handle communications routed by this rule

■ The skill competency level required for this routing rule

■ The escalation times for each route

Because Siebel Universal Queuing is solely a routing engine, it can route (or find an 
agent for) any work item that contains work item characteristics that can be 
matched to routing rules.

The communications toolbar in the Siebel application allows agents to manage 
communications received from the configured communications channels. 
Communications are routed to an agent based on selection performed by Siebel 
Universal Queuing. 

Managers can monitor work load response times and agent availability, and modify 
routing rules in real time.
12 Siebel Universal Queuing Administration Guide Version 7.5
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Universal Queuing Architecture
This section describes the overall relationship between the Siebel Universal 
Queuing routing engine and Siebel eBusiness Applications. It also describes the 
interface between the routing engine and the applications.

Overall Architecture
Siebel Universal Queuing includes the following components:

■ The Siebel Universal Queuing routing engine, which is installed separately from 
Siebel Server and runs either on the same machine as Siebel Server or on a 
separate machine. For performance reasons, it is recommended that you install 
the Siebel Universal Queuing routing engine on a separate machine by itself.

■ Siebel Universal Queuing business service methods, which handle 
communications with Siebel Communications Server and other Siebel modules.

■ The Siebel Universal Queuing application programming interface (API), which 
provides the mechanism for routing engine functionality to interface with Siebel 
eBusiness Applications. The Siebel Universal Queuing API is application-
independent, allowing customers to integrate a third-party routing engine with 
Siebel eBusiness Applications, if desired, and to configure channels, route, and 
other elements in the manner described in this book.

You can request additional information about the Siebel Universal Queuing API 
from Siebel SupportWeb (http://ebusiness.siebel.com/supportweb/).

■ The UQ Administration screen included with Siebel eBusiness Applications, 
which allows administrators to configure and administer the routing engine.

Siebel Universal Queuing works with a number of Siebel modules or products, such 
as Siebel Communications Server, Siebel CTI, and Siebel eMail Response. These 
modules work together to make the routing process work.

The communication protocol between Siebel Server and the Siebel Universal 
Queuing routing engine is HTTP. Because the communication protocol is HTTP, the 
routing engine may be run on a separate platform from Siebel Server. 
Version 7.5 Siebel Universal Queuing Administration Guide 13



Overview of Siebel Universal Queuing

Universal Queuing Architecture
Communications with the Siebel Universal Queuing routing engine are through the 
Siebel Universal Queuing API. The API will package the internal Siebel Universal 
Queuing request data into Simple Object Access Protocol (SOAP) format with 
embedded XML. The data is embedded into the body of an HTTP packet and the 
packet is sent directly to the routing engine through HTTP. 

Each Siebel Universal Queuing client, such as Siebel Communications Server 
establishes a connection to the routing engine through the Universal Queuing API. 
Voice calls and email requests are sent through the Communications Inbound 
Manager.

When requests are sent through the Universal Queuing API, the request data will 
be converted into XML. Siebel Universal Queuing business service will add a SOAP 
envelope on top of the XML. Once the XML document is ready, it is sent to the Siebel 
Universal Queuing routing engine using the client’s established connection.

Upon receiving the request, the Siebel Universal Queuing routing engine always 
responds synchronously about whether the request has been processed or not. 
Depending upon the request, the routing engine will also send back an 
asynchronous response to the Siebel Web server. The Siebel Web server will route 
this request to the Siebel EAI Object Manager. The EAI Object Manager then invokes 
the Siebel Universal Queuing business service, based upon the EAI external services 
configuration. When EAI Object Manager receives the request in HTTP format, it 
extracts the data from the body and converts it to a Siebel internal format.

The Siebel Universal Queuing routing engine sends requests back to Siebel Server 
using a number of established connections to Siebel Web server. The information 
about how to establish a connection to the Web server is provided to the routing 
engine during the initial OpenConnection request. In this request, Siebel Server tells 
the Siebel Universal Queuing routing engine the URL that needs to be sent to the 
Siebel Web server in order to establish the connection. 

Because each connection to EAI Object Manager through the Web server is only 
served by one thread, it is important to establish the optimum number of 
connections so that maximum performance is achieved. The number of connections 
is set using the MaxConnections parameter when defining the Siebel Universal 
Queuing configuration. For more information about this parameter, see Table 7 on 
page 58.
14 Siebel Universal Queuing Administration Guide Version 7.5
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Universal Queuing Architecture
Figure 1 illustrates the general architecture of a communications system using 
Siebel Universal Queuing. Refer to Siebel Communications Server Administration 
Guide for more information on the Siebel Communications Server architecture.

The Siebel Universal Queuing routing engine comprises the following major 
components:

■ UQ Connector. Provides the gateway between Siebel Server and the Siebel 
Universal Queuing routing engine, using the HTTP protocol.

■ SOAP interface adapter. Bridges the gap between the UQ Connector and the SOAP 
interface, and manages the details of the SOAP protocol.

Figure 1. Siebel Universal Queuing Architecture
Version 7.5 Siebel Universal Queuing Administration Guide 15
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■ ADU Server. Stores agent state, including the channel state for each channel type 
for which the agent can receive work items. The Agent Data Unit (ADU) is 
created for each agent upon login and remains until the agent logs out.

■ Contact Record Server. Stores work item state from the time a work item is first 
introduced into the Siebel Universal Queuing routing engine until the last agent 
completes work on the work item. Support services are called as needed. For 
example, the Data Unit (DU) Store Server provides a persistent copy in the 
database (DUStore table) of items stored in the ADU and Contact Record servers; 
the Directory server supplies configuration information to the servers.

■ ATD Server. Contains the logic for managing work item state, agent state, and 
work item routing based on work item data properties and agent skills. To match 
a work item and an agent, the Automatic Task Distributor (ATD) Server performs 
these basic operations:

■ Assigns an available agent to a new work item when it arrives, and queues 
the work item if no agent is available.

■ Finds a work item for an available agent, and leaves the agent available if no 
work item is found.

■ Looks for work items that expire in each escalation step and moves them to 
the next escalation step. Then tries to assign an available agent, queuing the 
work item if no agent is available.
16 Siebel Universal Queuing Administration Guide Version 7.5
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Siebel Universal Queuing Elements
This section gives an overview of the elements that you need to understand before 
you begin to configure and use Siebel Universal Queuing:

■ Work items

■ Configurations

■ Channels and channel types

■ Employee skill definitions and expertise

■ Simultaneous sessions

■ Routes, route properties, and escalations

■ Real-time and historical statistics

■ Alarms and errors

Work Items
Siebel Universal Queuing queues and routes work items. A work item represents a 
real-time or a nonreal-time workflow task. A real-time work item, such as a voice 
call, has an associated live session. A nonreal-time work item is a passive request 
for an action, such as an email asking for more information, a fax requesting a 
magazine subscription, or a service request that needs to be addressed. Email, 
service requests, activities, or other items may be defined either as real-time or as 
nonreal-time work items.

Each work item has a set of associated properties. For example, an email work item 
has an email message ID, sender’s email address, receiver’s email address, subject, 
and so on.

A work item is delivered to the Siebel Universal Queuing routing engine through the 
Siebel communications infrastructure. The Siebel Universal Queuing routing engine 
uses the work item’s data properties to find a matching route. After the work item 
is matched to a route, the routing engine uses the skill requirement in each of the 
matching route’s escalations steps to locate a qualified agent. When the routing 
engine finds a suitable, available agent to handle the work item, the work item is 
passed back to Siebel Communications Server to be handled by the agent.
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Work Item Delivery Models
An agent has the capability of handling more than one concurrent work item for a 
given channel. The Siebel Universal Queuing administrator determines how many 
simultaneous sessions each agent can handle for each channel.

An agent can receive work items in one of the following ways:

■ Siebel Universal Queuing working with Siebel Communications Server assigns 
and pushes real-time work items to an agent as soon as the agent becomes 
available to receive a new work item.

The agent must be logged on and in a ready state to receive a new real-time work 
item. The Accept Work Item button on the communications toolbar blinks when 
the work item is received and the agent must explicitly accept the work item. 
The work item is returned to the queue and rerouted if not accepted by the agent 
within a specified period of time, and the agent state is changed to not ready.

■ The agent can select a work item from a list of available work items for which 
the agent is qualified. The work items are managed by Siebel Universal Queuing. 
This model is also known as cherry picking.

The agent must be logged on and in a ready state to select a work item from the 
list. For more information, see “Selecting Work Items from My Qualified Work 
Items View” on page 99.

■ Siebel Universal Queuing, working with Siebel Communications Server, assigns 
nonreal-time work items to an agent, regardless of the agent’s ready or not ready 
state.

The agent must be logged on to receive a new nonreal-time work item. The agent 
also must periodically check the appropriate view, such as the My Service 
Requests view of the Service screen or the My Communications view of the 
Communications screen, to determine if new nonreal-time work items have 
been received. The buttons on the communications toolbar do not blink for new, 
nonreal-time work items.
18 Siebel Universal Queuing Administration Guide Version 7.5



Overview of Siebel Universal Queuing

Siebel Universal Queuing Elements
Configurations
The Siebel Universal Queuing configuration parameters, described in Table 7 on 
page 58, specify settings that tell Siebel Server how to connect to the Siebel 
Universal Queuing routing engine.

You must define at least one Siebel Universal Queuing configuration and make this 
the primary configuration. You can define multiple configurations, but only one 
configuration can be set as primary. The primary configuration is used by default 
when an attempt is made to connect to the routing engine and no Siebel Universal 
Queuing configuration is specified in the agent’s communications configuration, or 
the agent is not defined in any communications configuration.

When call center agents are configured in Siebel Communications Server, they are 
assigned to a communications configuration. When creating a communications 
configuration in the Communications Administration screen, you can specify a 
particular Siebel Universal Queuing configuration for your agents to use, by using 
the UQConfigurationName parameter.

For more information on Siebel Universal Queuing configurations, see “Defining 
Configurations” on page 57. For information on communications configurations, 
see “Defining Communications Configurations” on page 71, and refer to Siebel 
Communications Server Administration Guide.

Channels and Channel Types
A channel defines the communication media for a work item that is routed through 
Siebel Universal Queuing. A channel is typically based on one of the following 
channel types:

■ Voice

■ Email

■ Service request

■ Activity
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The channel is one of the characteristics that defines a work item. The channels that 
will be available to your implementation of Siebel Universal Queuing are defined by 
your communications administrator. The channel can be anything as long as it can 
be passed to the routing engine along with the work item. For example, you can 
specify multiple channels based on the email channel type: Email-support, 
Email-service, Email-sales, and so on, according to your organization’s needs.

Each channel also has channel properties, which are a superset of the values that 
the work items for the channel may contain. For example, an email channel might 
have a SenderAddress property. A subset of these properties is used to create the 
routing rules that will be matched to work item properties.

NOTE: Service requests and activities are nonreal-time work items. Email messages 
may be configured as either realtime or nonreal-time work items. Routing nonreal-
time work items refers to assigning ownership for such items. Agents are not 
notified directly, as they are with realtime work items that are sent to the agent’s 
Siebel desktop through the communications toolbar.

For more information on channels and channel types, see “Defining Channels” on 
page 65.

Employee Skills and Expertise
Employees are the individuals to whom Siebel Universal Queuing will route work 
items. Employees are defined for your organization using the User Administration 
screen. Specific call center employees are further defined as agents through Siebel 
Communications Server, where communications drivers are assigned to the agents.

For more information on defining agents, refer to Siebel Communications Server 
Administration Guide. For more information on defining employees, refer to 
Applications Administration Guide.

Since Siebel Universal Queuing uses a skill-based routing algorithm, each employee 
that will use Siebel Universal Queuing must have skills and expertise levels 
assigned. Siebel Universal Queuing then matches employee skills and expertise to 
work item data properties to route the work item.

For more information on employee skills and expertise, see “Assigning Employee 
Skills” on page 67.
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Simultaneous Sessions
Simultaneous sessions are the number of work items for a channel that an employee 
can work on simultaneously. An employee must have at least one simultaneous 
session defined for a channel type in order for Siebel Universal Queuing to consider 
that employee when routing work items for that channel. For some channel types, 
such as email, an employee may be able to handle multiple work items at one time 
and would be assigned more than one simultaneous session for this channel type.

NOTE: When sequential assignment is used, then you must set the simultaneous 
sessions specified for each applicable channel, for each agent, as described in 
“Configuring Sequential Assignment” on page 73.

For more information on defining simultaneous sessions, see “Defining Employee 
Channel Capacity” on page 69.

Routes, Route Properties, and Escalations
Work items are handled by Siebel Universal Queuing according to business logic 
expressed as routes. A route has these components:

■ Route record

■ Route properties (selection criteria)

■ Escalation steps

Selection criteria consist of simple to complex statements that Siebel Universal 
Queuing evaluates based on the properties of a work item. If the work item 
characteristics match the selection criteria, the work item is routed based on the 
escalation steps. For more information, see “Defining Routes, Route Properties, and 
Escalation Rules” on page 84.

Escalation steps determine how a work item will be routed based on a set of skill 
definitions and wait times. Skill definitions are used to match a work item with an 
employee who holds the same skill criteria defined for handling the work item. The 
wait time determines how long a work item waits for an available employee in this 
escalation step before moving to the next escalation step. Each escalation step 
should generally become more liberal by including a larger pool of employees that 
can handle the work item.
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Real-Time and Historical Statistics
You can view statistics on the performance of employees, channels, and routes for 
specific time intervals. This is useful in helping you determine the most efficient 
deployment of your call center resources.

For more information on real-time statistics, see “Viewing Real-Time Status Data” 
on page 106.

Siebel Universal Queuing maintains activity journals for work items and employees. 
From these journals you can view historical data on routes and channels for a time 
period that you specify.

For more information on historical statistics, see “Viewing Historical Data” on 
page 110.

Alarms and Errors
Siebel Universal Queuing generates alarms and errors and logs them to the 
database. Alarms and error messages can be viewed using the UQ Administration 
screen. 

Alarms are classified using the following designations and criteria:

■ Informational. Events requiring no action or intervention, such as reporting 
initialization progress.

■ Warning. Events that require action, but not necessarily immediate action. There 
is no immediate degradation in system capabilities or performance. Examples 
include memory utilization hitting a predetermined threshold, or number of 
users approaching the system limits.

■ Critical. Immediate action is required, and the system capability is degraded. An 
example is a missing required parameter on an API method, or inability to 
continue to write log information.

■ Emergency. Immediate action is required, and the system may fail to perform in 
a useful manner. An example is the inability to connect to the database.

For more information on viewing alarms and errors, see “Viewing Alarms and 
Errors” on page 104.
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How Siebel Universal Queuing Works
This section describes how Siebel Universal Queuing receives and routes incoming 
work items.

Agent Login
Call center agents are configured to use Siebel Universal Queuing by assigning the 
agent to a communications configuration that includes Siebel Universal Queuing. 
The agent is logged into the routing engine using the Siebel Universal Queuing 
configuration specified in the communications configuration. If no configuration 
name is specified, the agent is logged in using the Siebel Universal Queuing primary 
configuration.

For more information on agent configuration and logon, refer to Siebel 
Communications Server Administration Guide.

The first time an agent attempts to log into Siebel Universal Queuing after 
installation or system restart, Siebel Server sends a request establishing a 
connection to the routing engine. The connection is established using the Siebel 
Universal Queuing configuration specified in that agent’s communication profile or 
the primary configuration, if none is specified. 

Next, Siebel Server asks Siebel Universal Queuing if routing rules and skill 
definitions are loaded into memory. If not, the routing rules and skills are loaded 
from the Siebel database. Siebel Universal Queuing also supports reloading routing 
rules and skill definitions while agents are logged in by using the Notify UQ button 
in the Routes and Employees views in the UQ Administration screen. Notify UQ 
reloads all routing rules and skills, not just those that have been changed. 

Once the connection is established with Siebel Server and the rules have been 
loaded, the agent is logged into Siebel Universal Queuing. Siebel Universal Queuing 
sends a request to Communications Server to place the agent in ready mode (or not 
ready, depending on the configuration). The agent is now ready to accept work 
items for the channel type specified in simultaneous sessions for that agent.

For more information about using the Notify UQ button, see “Notifying Siebel 
Universal Queuing of Updates” on page 83.
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Receiving Work Items
Examples of work items destined for routing by Siebel Universal Queuing are 
received as follows:

■ Voice calls and email. These work items are received by the Communication 
Inbound Manager in Siebel Communications Server. The voice calls and email 
messages are then packaged and sent to the Siebel Universal Queuing routing 
engine through the Siebel Universal Queuing API.

Routing Work Items
The Siebel Universal Queuing routing engine receives each work item and uses a 
skills-based routing algorithm to match the work item properties with one of its 
routing rules. 

For example, a work item received with a channel property of email and a language 
property of U.S. English (ENU) would match a routing rule with the same 
properties. When the work item matches a route, the next step is to find an 
appropriate agent to handle the work item. This happens by matching the skill 
criteria defined in the escalation step. 

Once an agent is found, the routing engine routes the work item in this example 
back through Siebel Communications Server to the next available qualified agent. 
Work items can be routed to an available agent if, for this agent, simultaneous 
sessions is set to at least one for the channel type email and the language skill of 
ENU is defined. If more than one agent matches the routing rule, the work item is 
routed to the agent who was least recently assigned a work item.

Escalations
Each route includes escalation steps which define the skill requirements for an 
agent to handle the work item. One or more escalation steps can be defined to 
widen the choice of qualified agents when no agent is available that matches the 
ideal set of skill requirements for the work item. 
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When a work item is matched to a route but no qualified agents are currently 
available to accept the work item, the work item waits in the first escalation step 
for the next available agent. Each escalation step includes a time limit that a work 
item can remain queued. When the elapsed time that a work item has been in the 
step reaches the time limit, the work item is moved to the next escalation step for 
the route. If a work item remains in the last escalation step beyond its time limit, 
an alarm is generated and logged.

NOTE: Escalation steps consider agent availability only for real-time work items.

Agent Availability and Sequential Assignment
Siebel Universal Queuing manages the agent availability state for the agents logged 
into the routing engine so that work items can be assigned to agents that are 
available. As an agent’s availability is changed by the routing engine, the new state 
is sent back to Siebel Communications Server and the communications toolbar is 
updated to reflect the new state.

Siebel Universal Queuing supports two alternative approaches to implementing 
sequential assignment, which is a way of configuring Siebel Universal Queuing that 
limits an agent to handling one inbound work item at a time. The work items—
across channels—are assigned sequentially. The two approaches, which are not 
mutually exclusive, are:

■ Using the Wrap Enabled configuration parameter

■ Using sequential assignment as defined in the file callrouteA.def

The two sequential assignment options are ways of simplifying work-item handling 
for agents. Use Wrap Enabled = TRUE when agents need time to do wrap-up work 
after releasing a work item.

If you choose not to use either approach, then multiple work items may be assigned 
to an agent at once, subject to each channel’s maximum number of simultaneous 
sessions.

For more information about these two methods, see “Configuring Sequential 
Assignment” on page 73.
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Siebel Universal Queuing Implementations
Customers can implement one of the following two general communications 
configurations to use Automatic Call Distribution (ACD) with Siebel Universal 
Queuing:

■ Use Siebel Universal Queuing as the exclusive multichannel queuing module. 
The Siebel Adaptive Communications application programming interface (API) 
will support the route requests. Any custom Siebel communications driver based 
on this API, such as for Siebel CTI (Computer Telephony Integration), must 
implement this functionality, and be able to send route requests to Siebel 
Universal Queuing for agent assignment.

For information about the Siebel Adaptive Communications API and creating 
communications drivers, refer to Siebel Communications Server Administration 
Guide.

■ Use ACD for voice calls and Siebel Universal Queuing for all other 
communication channels. This can be accomplished by creating two 
communications configurations: one for voice with ACD and one for other 
channels using Siebel Universal Queuing. Agents can be assigned to one or the 
other of these configurations, so they will not receive work items from both 
systems.

For information about creating communications configurations, refer to Siebel 
Communications Server Administration Guide.
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Using Siebel Universal Queuing with Other Siebel 
Modules

This section provides high-level information about how Siebel Universal Queuing 
works with closely related product modules. Several Siebel modules use Siebel 
Universal Queuing to route incoming communications work items to the most 
appropriate call center agent.

Siebel Server Requirements for Siebel Universal Queuing
In order to use Siebel Universal Queuing, you must have the following Siebel Server 
components enabled and running:

■ Communications Session Manager (CommSessionMgr). Supports multichannel 
user-interactive sessions for agents using the communications toolbar for voice, 
email, or other types of work items. This Siebel Communications Server 
component belongs to the Communications Management component group. For 
more information, see “Siebel Universal Queuing and Siebel Communications 
Server” on page 28.

■ Communications Inbound Manager (CommInboundMgr). Processes inbound work 
items, including voice or email work items that are to be routed using Siebel 
Universal Queuing. This Siebel Communications Server component belongs to 
the Communications Management component group. For more information, see 
“Siebel Universal Queuing and Siebel Communications Server” on page 28.

■ EAI Object Manager. This server component, part of the Siebel eBusiness 
Application Integration technology suite, provides the mechanism by which the 
Siebel Universal Queuing routing engine communicates with the Siebel 
application, over HTTP. For more information, refer to Overview: Siebel 
eBusiness Application Integration Volume I and related documentation.

For more information about configuring connections from the Siebel Universal 
Queuing routing engine to these server components, see “Configuring Siebel 
Universal Queuing” on page 55.
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Siebel Universal Queuing and Siebel Communications Server
Siebel Universal Queuing works in conjunction with Siebel Communications Server 
to route incoming work items to appropriately skilled agents who have logged into 
Siebel Universal Queuing.

Agents log in from the communications toolbar or from a menu command. An agent 
becomes aware of a routed work item through a blinking Accept Work Item button 
on the communications toolbar. An agent uses other buttons on the 
communications toolbar to alert Siebel Universal Queuing of the agent’s ready state, 
so that Siebel Universal Queuing can route communications appropriately.

For a detailed data flow description for voice and email work items, see “Siebel 
Universal Queuing Data Flow” on page 30. For more information about Siebel 
Communications Server, including server components in the Communications 
Management component group, refer to Siebel Communications Server 
Administration Guide.

Siebel Universal Queuing and Siebel CTI
Siebel CTI (Computer Telephony Integration) provides voice-channel support for 
call center agents using Siebel eBusiness Applications. Siebel CTI is included with 
Siebel Call Center. For other base applications, it is an optional module. CTI 
capabilities are provided through integration with third-party CTI middleware 
packages such as Dialogic CT Connect (included in Siebel CTI Connect).

Call routing may be handled by Siebel Universal Queuing and agents are notified of 
incoming calls through the communications toolbar. 

For a detailed data flow description, see “Voice Call Data Flow” on page 30. For 
more information about Siebel CTI, refer to Siebel Communications Server 
Administration Guide.
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Siebel Universal Queuing and Siebel eMail Response
Siebel eMail Response, available as an optional module, allows agents to receive 
and reply to inbound email messages.

Siebel eMail Response may use Siebel Universal Queuing to route incoming email 
messages to call center agents. An agent must be identified in the 
UQ Administration screen as able to accept email messages and must be logged in 
before Universal Queuing can route an incoming email message to the agent. 

For a detailed data flow description, see “Email Data Flow” on page 31. For more 
information about Siebel eMail Response, refer to Siebel eMail Response 
Administration Guide.
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Siebel Universal Queuing Data Flow
This section describes how work items enter and are routed through Siebel 
Universal Queuing.

Voice Call Data Flow
The following scenario describes the data flow for a voice call work item.

1 A customer makes a call to a call center. The number the customer dialed (DNIS) 
is mapped to a route point on the telephone switch.

2 The CTI middleware generates a route request. This request is then sent to the 
Siebel CTI driver.

3 The Siebel CTI driver sends the event to the Communications Inbound Manager.

4 Communications Inbound Manager receives the event and then executes the 
voice routing workflow to package the call data.

5 Communications Inbound Manager then invokes the Universal Queuing 
business service in one of the workflow steps in order to send the call request 
to the Siebel Universal Queuing routing engine.

6 The routing engine receives this call route request and tries to find a matching 
routing rule based upon the data properties in the call work item.

7 Once a routing rule is found, the routing engine looks at the first escalation step 
to determine which kind of skill for the agent is required. 

If no agent is found in the first escalation step, the work item remains in this 
escalation step for a specified amount of time. When the time expires and no 
agent is available, the work item moves to the next escalation step and a new 
set of skill requirements.

8 Once an agent is found, the routing engine sends the call data together with the 
agent ID as a request to the Siebel EAI Object Manager.

9 The EAI Object Manager receives the request and then invokes the Siebel 
Universal Queuing business service to process the request.
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10 The Siebel Universal Queuing business service receives the request and 
determines that this request needs to be passed back to Communication 
Inbound Manager.

The determination is based upon the SiebelLoginID and ClientKey that are 
included in the work item properties. These two pieces of information are placed 
in the work item by the Communications Inbound Manager before it sends the 
work item to the routing engine.

11 Communications Inbound Manager determines the telephone extension for the 
assigned agent.

12 The Communications Inbound Manager issues, through the CTI driver, a route 
request to reroute the call to the extension for the agent.

13 The CTI driver issues the route request to the CTI middleware, which in turn 
sends the request to the switch.

14 The phone on the agent’s desktop rings and the Accept Work Item button on the 
communications toolbar blinks.

Email Data Flow
The following scenario describes the data flow for an email work item.

1 A customer sends an email to a service center. 

2 The Communications Inbound Manager is monitoring a specific email account 
on the email server.

3 Once the email message is received in the monitored email account, the email 
driver picks up the email.

4 Communications Inbound Manager executes an email workflow to process the 
email. One of the steps in the workflow is to package the data as a work item.

5 Communications Inbound Manager then invokes the Siebel Universal Queuing 
business service in one of the workflow steps to send the email request to the 
Siebel Universal Queuing routing engine.

6 The routing engine receives this email request and tries to find a matching 
routing rule based upon the data in the email work item.
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7 Once a routing rule is found, the routing engine looks at the first escalation step 
to determine the required skill for an agent.

8 Once an agent is found, the routing engine sends the email data, together with 
the agent ID, as a request to the EAI Object Manager.

9 The EAI Object Manager receives the request and then invokes the Siebel 
Universal Queuing business service to process the request.

10 The Siebel Universal Queuing business service sends this request back to the 
Communications Session Manager.

11 Communications Session Manager processes the email by blinking the Accept 
Work Item button so that the agent can answer the email request.

12 When the email request is answered, the email message will be retrieved from 
Siebel database and displayed to the agent.
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This chapter describes how to install and configure the Siebel Universal Queuing 
routing engine. This chapter also includes information on configuring Siebel 
applications to use Siebel Universal Queuing.
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Preparing to Install Siebel Universal Queuing
Siebel Universal Queuing can be installed before, during, or after the installation of 
other Siebel components. However, it is strongly recommended that you install 
Siebel Server before you install Siebel Universal Queuing.

For more information, see the release notes and system requirements and supported 
platforms documentation for your Siebel applications.

NOTE: Siebel Universal Queuing and Siebel Server should be installed inside the 
same firewall for security reasons, since HTTP (not HTTPS) is used as the transport 
mechanism.

Server Configuration for the Routing Engine
You can choose to configure Siebel Universal Queuing to run in one of two ways:

■ In a single-server configuration—the default configuration.

■ In a dual-server configuration—where a primary set of Siebel Universal Queuing 
routing engine components resides on one machine and a backup set of 
components resides on a separate machine. The dual-server configuration 
facilitates redundancy.

The backup server is used by the Siebel Communications Server when the 
primary server is functionally unavailable, such as in the event of network 
failure, system shutdown, and so on.

NOTE: When you install a dual-server configuration, the information provided to 
the install program must be identical for both the primary and backup servers.

Data you input for these server configurations is described in the tables in this 
section. Additional data you input relating to your database is described in 
“Database Configuration for Recovery Table” on page 37. These sections are 
referenced from the installation procedures for supported Microsoft Windows and 
UNIX platforms, in “Installing Siebel Universal Queuing” on page 41.
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In completing data input for single-server or dual-server configurations, refer to the 
following paragraphs for additional explanation:

Internal port allocation. The Siebel Universal Queuing routing engine uses a series of 
consecutively numbered TCP/IP ports for internal communication. Fourteen ports 
are allocated for this purpose, starting at the base port, which is designated by this 
setting. By default, the base port is 9000, thus ports 9000 to 9013 are used. 

Most users do not need to change the default value. Specify a different value if 
another application is already using the default port number.

UQ host port (SOAP port) for Communications Server. The UQ host port (or SOAP port) 
is used by Siebel Communications Server to connect to the Siebel Universal Queuing 
connector. By default, the UQ host port is 9100. Most users do not need to change 
this setting. If it is changed, a corresponding change is required for the 
configuration parameter UQ Host Port. For more information, see Table 7 on 
page 58.

IP address. The default IP address is the address of the local computer. If the 
computer is part of a network, then an internal IP address is returned, such as 
10.X.X.X, 192.X.X.X, or 168.X.X.X. Siebel Universal Queuing requires a static IP 
address. The IP address specified here may also be specified as the value of the UQ 
Host configuration parameter. For more information, see Table 7 on page 58.

Single-Server Configuration
Table 1 provides information required by the installation program for installing the 
Siebel Universal Queuing routing engine in the single-server configuration.

Table 1. Single-Server Configuration—Required Input

Input Default Notes

Hostname of server Current Hostname

IP address of server Current IP Address of the computer on which you are 
installing the routing engine. This address 
must be a static IP address.

Base port for server 9000 Siebel Universal Queuing requires fourteen 
port numbers starting with the base port.
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Dual-Server Configuration
The tables in this section provide information required by the installation program 
for installing the Siebel Universal Queuing routing engine in the dual-server 
configuration.

Table 2 provides information about installing on the primary machine in the dual-
server configuration.

Port for SOAP listener 9100 Port used by Communications Server to 
connect to Siebel Universal Queuing. 
(Corresponds to the UQ Host Port 
configuration parameter.)

Time interval 300 seconds Interval for sending statistics information to 
Communications Server.

Table 2. Primary Server in Dual-Server Configuration—Required Input

Input Default Notes

Hostname of primary server Current Hostname

IP address of primary server Current IP Address of the computer on which 
you are installing the routing engine. 
This address must be a static IP 
address.

Hostname of backup server

Base port for servers 9000 Siebel Universal Queuing requires 
fourteen port numbers starting with 
base port.

Port for SOAP listener 9100 Port used by Communications Server 
to connect to Siebel Universal 
Queuing. (Corresponds to the UQ 
Host Port configuration parameter.)

Time interval 300 seconds Interval for sending statistics 
information to Communications 
Server.

Table 1. Single-Server Configuration—Required Input

Input Default Notes
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Table 3 provides information about installing on the backup machine in the dual-
server configuration.

Database Configuration for Recovery Table
The Siebel Universal Queuing routing engine writes agent state and work-item state 
data to a table called DUStore. In the dual-server configuration, if the primary server 
fails for any reason, the backup server recovers the system state from the data in 
the DUStore table. In a single-server configuration, you can also recover the system 
state from this table.

NOTE: In order to restart Siebel Universal Queuing in a clean configuration (with no 
pending work items, no agents logged in, no rules loaded, and so on), the recovery 
data must be deleted from the DUStore table by a database administrator.

Table 3. Backup Server in Dual-Server Configuration—Required Input

Input Default Notes

Hostname of primary server Hostname of the primary server.

Hostname of backup server Current Hostname

IP Address of backup server Current IP Address of the computer on which 
you are installing the routing 
engine.

Base port for servers 9000 Siebel Universal Queuing requires 
fourteen port numbers starting 
with base port.

Port for SOAP listener 9100 Port used by Communications 
Server to connect to Siebel 
Universal Queuing.

Time interval 300 seconds Interval for sending statistics 
information to Communications 
Server.
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A database table creation script is available on the installation CD for all database 
platforms that Siebel eBusiness Applications support. The DUStore database table 
must be created by the database administrator. You can create a new database or 
use an existing database, such as the Siebel database, to contain this table. 

For instructions for creating the DUStore table, see “Creating the DUStore Recovery 
Table” on page 45.

For more information about database support, see the system requirements and 
supported platforms documentation for your Siebel applications.

The appropriate database client software for the database that you will use must be 
installed before you install the Siebel Universal Queuing routing engine. The 
installer detects which database drivers are installed and only displays the database 
options that are available on the server.

The installer requires information to connect to the database. The following tables 
show the required input for each supported database. The required input differs 
slightly for each database. The account name and password are required in each 
case.

Table 4 provides information for installing on Microsoft SQL Server.

Table 4. Microsoft SQL Server Database Information

Required Input Notes

Server Name The hostname where the SQL Server instance is running.

Database Name The name of the Siebel database in that instance.

Account Name A username to access the database.

Account Password Password for the username.
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Table 5 provides information for installing on IBM DB2.

Table 6 provides information for installing on Oracle.

Table 5. IBM DB2 Database Information

Required Input Notes

Database Alias The DB2 alias defined on the local machine that points to a 
specific database on the DB2 database server.

For UNIX systems, use the following form:

database_hostname.database_alias

where database_hostname refers to the DB2 database server 
machine name and database_alias refers to the DB2 database alias 
cataloged on the local UNIX machine.

Table Owner The schema name containing the Siebel database in that database.

DB2 Home Directory 
(UNIX systems only)

The directory on the local UNIX machine where the DB2 client 
software is installed—equivalent to $INSTHOME.

Account Name A username to access the database.

Account Password Password for that username.

Table 6. Oracle Database Information

Required Input Notes

Table Owner The owner or schema name containing the Siebel database.

Connection String The Oracle connection string, as defined in the file tnsnames.ora.

Oracle Home Directory The directory on the local machine where the Oracle client 
software is installed—equivalent to $ORACLE_HOME.

Account Name A username to access the database.

Account Password Password for that username.
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Optimizing IBM AIX and IBM DB2 Universal Database
When running Siebel Universal Queuing on the IBM AIX platform with an IBM DB2 
Universal Database, an experienced system administrator should perform the 
following steps in order to optimize performance. 

NOTE: These settings assume that Siebel Universal Queuing and IBM DB2 Universal 
Database are running on different machines, each running IBM AIX.

On the IBM AIX server machine on which Siebel Universal Queuing is running, add 
the following lines to the file /etc/rc.net:

if [ -f /usr/sbin/no ] ; then
/usr/sbin/no -o tcp_sendspace=65535
/usr/sbin/no -o tcp_recvspace=65535
/usr/sbin/no -o tcp_pmtu_discover=1
/usr/sbin/no -o tcp_nagle_limit=1
/usr/sbin/no -o fasttimo=50

fi

On the IBM AIX server machine on which IBM DB2 Universal Database is running, 
add the following lines to the file /etc/rc.net:

if [ -f /usr/sbin/no ] ; then
/usr/sbin/no -o fasttimo=200
/usr/sbin/no -o tcp_sendspace=32768
/usr/sbin/no -o tcp_recvspace=32768

fi
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Installing Siebel Universal Queuing
This section provides instructions for installing the Siebel Universal Queuing 
routing engine on supported Microsoft Windows and UNIX platforms.

Preinstallation Checklist
The preinstallation checklist helps you make sure that you have access to the 
information needed during the installation.

To prepare for a successful installation, determine the defaults you are going to 
accept, and the server and database configuration choices you have to make. See 
Table 1 on page 35 through Table 6 on page 39 for more information regarding the 
following issues:

■ The type of installation you want to perform: single-server or dual-server (if 
dual-server, you specify separate information for primary and backup server)

■ Primary server hostname and base port number

■ If using a backup server, the backup server hostname 

■ SOAP port number and the interval time

■ IP address

■ Choice of an appropriate database: 

■ Microsoft SQL Server database input requiring: server name, database name, 
account name, and password

■ IBM DB2 database input requiring: database alias, table owner, DB2 home 
directory (UNIX systems only), account name, and password

■ Oracle database input requiring: table owner, connection string, home 
directory, account name, and password
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Installing the Routing Engine on Microsoft Windows
The following procedure describes how to install the Siebel Universal Queuing 
routing engine on a Microsoft Windows system.

For more information, see the release notes and system requirements and supported 
platforms documentation for your Siebel applications.

To install the routing engine on Microsoft Windows

1 Log into the Microsoft Windows system as an administrator or a user with 
administrative privileges.

2 Insert the Windows Server Ancillary Programs CD into the CD-ROM drive of the 
chosen computer.

3 Select Siebel Universal Queuing.

4 When the welcome screen appears, click Next and follow the prompts to 
continue with the installation process.

As the installer guides you through the installation process, it validates the 
system, and installs the routing engine. You are prompted to reboot after the 
installation.

5 Click Finish and reboot the system.

Uninstalling on Microsoft Windows
The following procedure gives instructions for uninstalling the Siebel Universal 
Queuing routing engine from your Microsoft Windows system.

To uninstall the routing engine on Microsoft Windows

1 Click Start > Settings > Control Panel, and double click Add/Remove Programs.

The Add/Remove Programs dialog box appears.

2 Select Siebel Universal Queuing Server.

3 Click Add/Remove.

The Siebel Universal Queuing uninstall dialog box appears.
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4 Click Yes to finish uninstalling the routing engine.

5 Reboot the system after removing the software.

Installing the Routing Engine on UNIX
The following procedure gives instructions for installing the Siebel Universal 
Queuing routing engine on supported UNIX platforms.

For more information, see the release notes and system requirements and supported 
platforms documentation for your Siebel applications.

To install the routing engine on UNIX

1 Log in as root, or as another user with root access, on the chosen computer.

Root access is required in order to authenticate the user who is performing the 
installation. Depending on your system, you may need to log in as the root user.

2 Insert the Server Ancillary Programs CD for your supported UNIX platform into 
the CD-ROM drive of the chosen computer.

3 Mount the CD-ROM, if required, to make it accessible.

4 Navigate to the following directory on the CD-ROM:

Thirdpty/enu/universal_queuing/avaya/uq

5 To start the Siebel Universal Queuing installation script, type the following 
command in the directory in which the script is located on the CD, and press 
Enter:

./install

You receive the following message:

The Universal Queuing Server will be installed on this computer.

6 To continue the installation, press Enter.

7 Verify the path where Siebel Universal Queuing will be installed, or specify a 
different installation directory.

The directory scomm/uq is created in the directory you specify here.
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8 Choose the type of installation:

■ Single Server

■ Dual Server - Primary with Backup

■ Dual Server - Backup

For more information about Step 8 and Step 9, see “Server Configuration for the 
Routing Engine” on page 34.

9 Choose the appropriate settings for configuring the server for which you are 
performing the installation.

10 Choose the appropriate database type option: Oracle or IBM DB2.

For more information about Step 10 and Step 11, see “Database Configuration 
for Recovery Table” on page 37.

11 Provide the required information for configuring your chosen database type in 
order to install the database recovery table DUStore.

12 Verify that the confirmation screen reflects the correct configuration parameters.

If changes are required, select the desired options during confirmation. For 
descriptions of the configuration parameters, see Table 7 on page 58.

When all files have been extracted and the installation is finished, you receive 
the message “Installation Complete.”

Starting Universal Queuing Services After Installing
The routing engine (UQ services) does not start automatically after installation on 
UNIX systems, unless you take further steps. You have two choices:

■ Start the UQ services manually after installing. For information about restarting 
the UQ services manually, see “Running the Siebel Universal Queuing Routing 
Engine” on page 47.
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■ Configure the UQ services to start automatically the next time the machine is 
restarted. Optionally, the installer can also start the UQ services manually 
immediately after installing.

When you install, the following lines are written to the shell output and to the 
installation log file (install_dir/scomm/uq/logs/uqinstall.log). To configure the 
UQ services to start automatically, append the files as directed.

Please append the file install_dir/scomm/uq/etc/
inetd.conf.append to your System File /etc/inetd.conf

Please append the file install_dir/scomm/uq/etc/
services.append to your System File /etc/services

In these lines, install_dir is the directory into which you installed the Siebel 
Universal Queuing routing engine in Step 7 on page 43.

Creating the DUStore Recovery Table
Use the following procedure to create the DUStore table for your supported 
database, as may be required for your Siebel Universal Queuing configuration. This 
database table must be created by the database administrator. This procedure can 
be run before or after you install Siebel Universal Queuing.

For more information, see “Database Configuration for Recovery Table” on page 37.

To create the DUStore table

1 Log into your database as an administrator or a user with administrative 
privileges.

2 Insert the Server Ancillary Programs CD for your supported platform into the 
CD-ROM drive of the chosen computer.

3 UNIX only: mount the CD-ROM, if required, to make it accessible.

4 Navigate to the following directory on the CD-ROM:

Windows: Thirdpty\enu\universal_queuing\avaya\Database Scripts

UNIX: Thirdpty/enu/universal_queuing/avaya/Database Scripts
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5 Depending upon the database you will use for the DUStore table, run one of the 
following scripts, using an SQL analyzer tool supported by your database.

■ dustore_mssql.sql

■ dustore_db2.sql

■ dustore_oracle.sql

Reconfiguring Siebel Universal Queuing After Installation
During installation of the Siebel Universal Queuing routing engine, various 
operating system parameters are tested by the installer to determine if conditions 
are appropriate to continue with the setup process.

Required configuration parameters, including those specifying server IP addresses 
and ports, API ports, failover configuration, or other settings, are specified during 
the installation so that, after the installation, the subsystem is ready to run. For 
more information about configuration parameters, see Table 7 on page 58.

The desired configuration is selected during installation. Limited reconfiguration is 
available by running the installation program again using the Repair option.

NOTE: A complete reinstallation is required if you change the database connection 
information.
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Running the Siebel Universal Queuing Routing Engine
The Siebel Universal Queuing routing engine runs on a server in the background. 
All processes can be configured to automatically start when the server starts up. 
This section describes how you can determine if the processes are running and 
describes how to start them for Microsoft Windows and UNIX platforms.

For information on Siebel Universal Queuing routing engine or Siebel 
Communications Server failure procedures, see “Implementing Failure Recovery” 
on page 51.

Verifying and Running Routing Engine Processes on Microsoft Windows
This section describes how to verify that the Siebel Universal Queuing routing 
engine processes are running properly on Microsoft Windows platforms. 
Instructions for starting the services to run these processes are also included. 

The following are the processes to verify:

■ adusrv.exe

■ armsrv.exe

■ vdusrv.exe

■ dssrv.exe

■ orbsrv.exe

■ qatdsrv.exe

■ qntinetd.exe

■ qntorbsrv.exe

■ quqconnector.exe

■ dustore.exe (This process may not be running for a single-server configuration 
where no database information was specified.)
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To check if all routing engine processes are running

1 Using the right mouse button, click a blank area on the taskbar.

2 Choose Task Manager.

The Windows Task Manager dialog box appears.

3 Verify that the processes listed earlier are running.

4 If any processes are not running, restart the routing engine services as described 
in “Starting the Routing Engine Services on Microsoft Windows.”

Starting the Routing Engine Services on Microsoft Windows
This section describes how to start the routing engine services on Microsoft 
Windows. The two services that must be running are:

■ UQ Engine - Data Service

■ UQ Engine - Orb Service

To start the routing engine services

1 Do one of the following, according to your Microsoft Windows platform:

■ On Microsoft Windows NT: choose Start > Settings > Control Panel > 
Services, select UQ Engine - Orb Service, and click Start.

■ On Microsoft Windows 2000: choose Start > Settings > Control Panel > 
Administrative Tools > Component Services, select UQ Engine - Orb Service 
(from “Services (Local)”), and click the Start Service button.

2 Repeat Step 1 for the UQ Engine - Data Service, until both services are started.

Once these two services are started, all routing engine components should be up 
and running.
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Verifying and Running Routing Engine Processes on UNIX
This section describes how to verify that the Siebel Universal Queuing routing 
engine processes are running properly on supported UNIX platforms. Instructions 
for starting these processes are also included. 

The following are the processes to verify:

■ adusrv

■ armsrv

■ vdusrv

■ dssrv

■ orbsrv

■ qatdsrv

■ quqconnector

■ dustoresrv (This process may not be running for a single-server configuration 
where no database information was specified.)

To check if all routing engine processes are running

1 Type the following command:

ps -ef | grep uq

2 Verify that the processes listed earlier are running.

3 If any processes are not running or responding, restart the services, as described 
in “Starting and Stopping Routing Engine Processes on UNIX.”
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Starting and Stopping Routing Engine Processes on UNIX
This section describes how to start and stop the routing engine processes on 
supported UNIX platforms.

To start the routing engine processes

1 From the install_dir/scomm/uq/bin directory, type the following command:

start_cti start

where install_dir is the location where you installed the Siebel Universal 
Queuing routing engine.

2 Verify that the processes are running, as described earlier.

All routing engine components should be up and running.

To stop the routing engine processes

1 From the install_dir/scomm/uq/bin directory, type the following command:

start_cti stop

where install_dir is the location where you installed the Siebel Universal 
Queuing routing engine.

2 Verify that the processes are no longer running, as described earlier.
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Implementing Failure Recovery
This section describes the failure recovery procedures that occur during one of these 
two types of system failure:

■ Siebel Universal Queuing failure

■ Siebel Communications Server failure

In order to provide the ability to recover from failure, Siebel Universal Queuing 
saves information in the database at regular intervals. During that interval, the 
following critical state change for agents and work items are saved:

■ Agent states: LOGGEDIN, AVAILABLE, AUXWORK, LOGGEDOUT

■ Work item states: RECEIVED, QUEUED, SCHEDULED, ACTIVE, WRAPUP, 
COMPLETED

Heartbeat Protocol
The Siebel Universal Queuing routing engine can detect connection failures actively 
by implementing a heartbeat protocol with Siebel Communications Server.

In the heartbeat protocol, Siebel Communications Server sends a message with a 
sequence number to the routing engine on every request connection of each 
connection set. The message is sent at each interval as determined by the value of 
the Ping Interval parameter. The default value of this parameter is 30 (seconds). 
Upon receiving a heartbeat message, the routing engine echoes the sequence 
number back in the response and restarts the Ping Interval timer.

If the Ping Interval timer expires, it is automatically reset. If the Ping Interval timer 
expires two consecutive times, the routing engine declares the connection to have 
failed and initiates recovery as described in “Siebel Universal Queuing Failure,” 
below. If a heartbeat request is received with the sequence number out of order, the 
routing engine treats this the same as a timer expiration.

If Siebel Communications Server encounters a network error when issuing a 
heartbeat request, Siebel Communications Server will initiate failure recovery and 
reconnect as described in “Siebel Communications Server Failure” on page 53. 

For more information about setting the Ping Interval parameter, see Table 7 on 
page 58.
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Siebel Universal Queuing Failure
The Siebel Universal Queuing routing engine is designed not to lose any work items 
that have been successfully introduced into the system, regardless of subsequent 
errors or system failures. 

The dual-server configuration allows you to have two identical routing engine 
instances running on different machines: a primary machine controlling system 
state and a standby machine tracking system state without exerting any control. The 
standby instance recovers state information from the database when the primary 
instance fails.

The failover process is as follows:

1 The primary and standby instances start, negotiate roles, and arrive at one of the 
following modes:

a The starting Siebel Universal Queuing instance assigns the primary role to 
the other Siebel Universal Queuing instance. 

b If the assign request succeeds, the other instance returns an indication that 
it is up and active, and the requesting instance takes on the standby role.

c If the request fails, then this is the only routing engine instance, and it takes 
on the primary role.

d In the race condition, where both instance start and try to assign to each 
other at the same time, the instances detect this and fall back to static 
configuration, assigning roles through a random number exchange.

NOTE: A routing engine instance in standby mode must never accept a Siebel 
Communications Server connection.

2 The standby instance monitors the primary instance to determine when to 
transition from standby to primary mode. 

3 The standby instance transitions to primary mode after detecting that the 
primary instance is no longer available. Before it accepts a Siebel 
Communications Server connection, it tries to restore all the logged-in agent 
information and work-item information from the DUStore table. 
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4 The standby instance will then establish a connection to the Siebel Server using 
the connection information from the primary instance. 

5 The standby instance will also use the routing rules information from the 
primary instance to initialize itself. 

6 Once the connections are established to Siebel Server, the standby instance is 
ready to begin normal operation.

When the routing engine detects a failure on the socket carrying the statistics 
connection set, then the routing engine tries to reopen the connection. If it does not 
succeed after 10 attempts, the routing engine raises a critical alarm. Statistics are 
not buffered, so failure to reconnect may result in a loss of statistics data. 

Siebel Communications Server Failure
When the Siebel Universal Queuing routing engine detects that it has failed to 
receive a heartbeat message from any active Siebel Communications Server 
connection, the following actions are taken: 

■ The routing engine attempts to send a critical alarm. However, this may not be 
possible if no other client asynchronous inputs are available. 

■ The routing engine logs out all agents that logged in through the failed Siebel 
Communications Server. 

The scenarios to consider for normal connection failures are as follows: 

■ The connection fails because Siebel Communications Server has failed—Siebel 
Communications Server does not recover, and agents fail over to another Siebel 
Communications Server. 

When the agents log in, they are using a different Communications Server and, 
therefore, a different connection ID, from the one used before the failure.
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When the routing engine detects that it no longer receives the heartbeat message 
within the time specified by the Ping Interval parameter, as a result of a Siebel 
Communications Server failure, but the agents have logged back in within the 
disconnect retry time, the following actions will occur:

■ Interactive items assigned to agents when Siebel Communications Server 
failed will be completed by the routing engine with a reason code of 
abnormal termination.

■ Noninteractive items will be requeued. There will be an agent journal entry 
created to account for the time period of the failure. 

■ Agent journal entries will be generated for affected agents to indicate that the 
agent logged in again after the failure. If, after the disconnect retry time, the 
agent has not logged back in, then the work items that were assigned to that 
agent when the failure was detected will be requeued. 

■ The connection fails because Siebel Communications Server has failed—agents 
do not fail over and do not promptly log in again. 

When the routing engine detects that it no longer receives the heartbeat message 
within the time specified by the Ping Interval parameter, as a result of a Siebel 
Communications Server failure, and the agents have not logged back in within 
the disconnect retry time, the following actions will occur: 

■ Interactive items assigned to agents when Siebel Communications Server 
failed will be completed by the routing engine with a reason code of 
abnormal termination. 

■ Noninteractive items will be placed back in queues. 

■ Agent journals will be generated for all agents logged in on the failed 
connection, with a logout reason code of connection failure. 
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Configuring Siebel Universal Queuing
This section describes the procedure for setting up your queuing system for the first 
time. It also describes how to modify the various elements in your system.

The following gives an overview of the order in which you define the elements in 
Siebel Universal Queuing:

1 Define the configuration parameters so that Universal Queuing can 
communicate with Siebel Server. For more information, see “Defining 
Configurations” on page 57.

2 Specify the channels for which work items will be routed by Siebel Universal 
Queuing. For more information, see “Defining Channels” on page 65.

3 Specify employee skills and expertise levels. For more information, see 
“Assigning Employee Skills” on page 67.

4 Determine, for each employee, the number of simultaneous sessions for each 
channel. For more information, see “Defining Employee Channel Capacity” on 
page 69.

5 Define the routing rules for each channel. For more information, see “Defining 
Routes, Route Properties, and Escalation Rules” on page 84.

6 Define the escalation steps for each route. For more information, see “Defining 
a Route Escalation” on page 91.

Views in the UQ Administration Screen
Siebel Universal Queuing is primarily configured using the UQ Administration 
screen. The views in this screen are listed here in the sequence in which you work 
with them. 

Views for Configuring Siebel Universal Queuing Elements
The following views are used to specify Siebel Universal Queuing configurations, 
channels, employees, and routes. The order in which the following views are 
arranged in the Show drop-down list is the order in which you will configure these 
elements.
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■ Configurations. Create, modify, copy, or delete a record for a named Siebel 
Universal Queuing configuration. Define the parameters associated with a 
configuration. For more information, see “Defining Configurations” on page 57.

■ Channels. Create or modify channels and specify associated properties for each 
type of media channel to be routed by Siebel Universal Queuing. Channel 
properties you define here are used in defining route properties. For more 
information, see “Defining Channels” on page 65.

■ Employees. View or modify information for each employee. Assign skill 
competencies and skill levels to be used for routing work items. Specify the 
number of work items for each channel an employee can work on 
simultaneously. For more information, see “Assigning Employee Skills” on 
page 67 and “Defining Employee Channel Capacity” on page 69.

■ Routes. Create, modify, copy, or delete routing and escalation rules for each 
channel type. For more information, see “Creating Routes and Escalations” on 
page 82.

Views for Reviewing Run-Time Status Data
The following views display run-time status information about channels, 
employees, and routes.

■ Channel Statistics. View activity information about the work items for each 
channel type. For more information, see “Viewing Channel Status Data” on 
page 106.

■ Employee Statistics. View detailed activity information about each employee that 
is logged into Siebel Universal Queuing. For more information, see “Viewing 
Employee Status Data” on page 107.

■ Route Statistics. View detailed activity information about the work items in each 
route. For more information, see “Viewing Route Status Data” on page 109.
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Other Views
The following views display historical information about channels, routes, and any 
alarms or errors that have occurred.

■ Historical Channel Statistics. View information about channel activity over a 
specified period of time. For more information, see “Viewing Historical Channel 
Statistics” on page 111.

■ Historical Route Statistics. View information about route activity over a specified 
period of time. For more information, see “Viewing Historical Route Statistics” 
on page 111.

■ Alarms and Errors. View information about warnings and errors that have 
occurred. For more information, see “Viewing Alarms and Errors” on page 104.

Defining Configurations
This section describes the configuration parameters that you define in order for 
Siebel Universal Queuing to communicate with Siebel Server. These configuration 
parameters only need to be defined once.

You can define multiple Siebel Universal Queuing configurations. However, you 
must specify one configuration as primary. The primary configuration is the 
configuration used as the default if no specific configuration is named when an 
attempt is made to connect to Universal Queuing. 

For example, when an agent is configured in Communications Server, you can 
optionally specify a Siebel Universal Queuing configuration using the 
UQConfigurationName parameter. This parameter is part of the communications 
configuration, which is administered in the All Configurations view of the 
Communications Administration screen. 

(The agent can specify the communications configuration to be in effect for the next 
session, using the Communications view of the User Preferences screen. For more 
information about communications configurations, refer to Siebel Communications 
Server Administration Guide.)
Version 7.5 Siebel Universal Queuing Administration Guide 57



Installing and Running Siebel Universal Queuing

Configuring Siebel Universal Queuing
If a Siebel Universal Queuing configuration is specified using the 
UQConfigurationName parameter, the agent will be connected to that instance of 
Siebel Universal Queuing upon logging in. If no Siebel Universal Queuing 
configuration is specified in the applicable communications configuration, then the 
agent will be logged in using the primary Siebel Universal Queuing configuration.

The primary configuration is especially important for determining how to route 
work items that are initiated by a customer from a Siebel application running on 
your company’s Web site. 

For example, if a customer is using Siebel eService or another Siebel application and 
initiates an email work item, this customer is not defined as an agent in a 
communications configuration. Because the UQConfigurationName configuration 
parameter is therefore not in effect for this customer, the Siebel Universal Queuing 
configuration to use for routing this work item is the one designated as the primary 
configuration.

Siebel Universal Queuing configuration parameters are listed and described in 
Table 7.

Table 7. Siebel Universal Queuing Configuration Parameters

Parameter Required? Description

AuxWork After Login N If this parameter is set to TRUE, the agent will be put 
into auxwork mode immediately after logging in. The 
agent must click the Change Ready State button in 
order to receive new work items.

The default value is FALSE.

Backup UQ Host Name N The name of the secondary Siebel Universal Queuing 
host. The secondary Siebel Universal Queuing is used 
for failure recovery purpose.

Backup UQ Host Port N The port number of the secondary Siebel Universal 
Queuing host.
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Connection Time Out N The timeout interval on logging in, sending requests, 
and receiving requests, in milliseconds. This value is 
used in the HTTP transport layer.

The default is 10 minutes (600000 milliseconds), 
which is usually enough. If the skill map is large and 
requires a long time to load when the routing rules are 
first loaded, set this parameter to a larger value.

Disconnect Retry Time N The number of retries before disconnecting, if there is 
any problem logging in, sending requests, and 
receiving requests. The default is 10 times.

The Connection Time Out parameter determines when 
a timeout will have been reached, after which another 
connection attempt may be made, according to the 
number of retries specified by Disconnect Retry Time.

HTTP Accept Header N For the HTTP header field HTTPAccept. The default 
value is “text/xml”. Do not modify this value.

HTTP Content Type N For the HTTP header field HTTPContentType. The 
default value is “text/xml”. Do not modify this value.

HTTPLoginBodyTemplate Y Login information for normal connections from the 
Siebel Universal Queuing routing engine to the EAI 
Object Manager on the Siebel Server. Normal 
connections (as compared with statistics connections) 
are used for processing communications work items.

See also the description of the MaxConnections 
parameter.

For example, this parameter might be defined as 
follows:

UserName=sadmin&Password=db2

HTTPLogoutURLTemplate N Logout information to disconnect the Siebel Universal 
Queuing routing engine from the EAI Object Manager 
on the Siebel Server, for normal connections.

If you set this parameter, define it exactly as follows:

SWEExtCmd=Logout

Table 7. Siebel Universal Queuing Configuration Parameters

Parameter Required? Description
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HTTPURLTemplate Y URL for normal connections from the Siebel Universal 
Queuing routing engine, through the Siebel Web 
server, to the EAI Object Manager on the Siebel Server.

For example, this parameter might be defined as 
follows:

http://web_server/obj_mgr/start.swe

where web_server is the Web server name and obj_mgr 
is the name of the virtual directory (on the Web 
server) for the EAI Object Manager. For example, this 
virtual directory name might be “eai_enu”.

Logout From Available N Agent can log out from the available state only if this 
parameter is set to TRUE. The default is TRUE.

MaxConnections N The number of connections that Siebel Universal 
Queuing will establish to the EAI Object Manager. The 
default is 3.

This specified number applies separately to both 
normal connections and statistics connections.

If, for example, MaxConnections is set to 3, then there 
will be a total of 6 connections established between 
Siebel Universal Queuing and the EAI Object Manager.

Note: The maximum number of statistics connections 
is always 5. For example, if MaxConnections is set to 
4, then the total number of EAI connections will be 8 
(4+4). However, if MaxConnections is set to 6, then 
the total number of connections will be 11 (6+5).

This parameter is mainly used for performance 
reasons.

Ping Interval N The number of seconds defining how often to ping 
Siebel Universal Queuing. The default is 30 seconds.

For more information, see “Implementing Failure 
Recovery” on page 51.

Table 7. Siebel Universal Queuing Configuration Parameters

Parameter Required? Description
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SecondaryHTTPLoginBodyTemplate Y Login information for secondary (statistics) 
connections from the Siebel Universal Queuing 
routing engine to the EAI Object Manager on the 
Siebel Server.

Statistics connections are used for messages that are 
not time-critical, such as alarm, error, journal, and 
statistics data. This data will be processed in a 
nontime-critical fashion.

Statistics connections may be to the same EAI Object 
Manager as for normal connections, which are used 
for processing communications work items. Or, you 
may prefer to connect to a separate EAI Object 
Manager.

Statistics connections are specified using the 
SecondaryHTTPURLTemplate parameter. See also the 
description of the MaxConnections parameter.

For example, this parameter might be defined as 
follows:

UserName=sadmin&Password=db2

SecondaryHTTPLogoutURLTemplate N Logout information to disconnect the Siebel Universal 
Queuing routing engine from the EAI Object Manager 
on the Siebel Server, for secondary (statistics) 
connections.

If you set this parameter, define it exactly as follows:

SWEExtCmd=Logout

SecondaryHTTPURLTemplate Y URL for secondary (statistics) connections from the 
Siebel Universal Queuing routing engine, through the 
Siebel Web server, to the EAI Object Manager on the 
Siebel Server.

For example, this parameter might be defined as 
follows:

http://web_server/obj_mgr/start.swe

where web_server is the Web server name and obj_mgr 
is the name of the virtual directory (on the Web 
server) for the EAI Object Manager. For example, this 
virtual directory name might be “eai_enu”.

Table 7. Siebel Universal Queuing Configuration Parameters

Parameter Required? Description
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Skill:skill_name Y Skill dictionary that contains a list of skills and 
associated skill items. This skill dictionary must be 
defined to include every skill definition that is to be 
used by the routing engine. Define your skills before 
you start Siebel Universal Queuing.

The value for Skill:skill_name is in this form:

BusObj,BusComp,Field

In order to correctly define instances of the Skill 
parameter, you must use the correct names for the 
applicable business objects, business components, 
and fields, as defined in Siebel Tools.

For example:

Skill:Email Recipient Name=CommSrv CM 
Adapter Administration,CommSrv CM 
Adapter Profiles,Name

Skill:Industry=Industry,Industry,Name

Skill:Language Code=Language 
Def,Language Def,Language Code

Skill:Product=Internal Product,Internal 
Product,Name

Note: In order to be able to define an instance of the 
Skill:skill_name parameter in the Configurations view, 
a corresponding List of Values entry of type 
UQ_CFG_PARAM must already exist. For more 
information about configuring Lists of Values, refer to 
Applications Administration Guide.

See also “Assigning Employee Skills” on page 67 and 
“Creating Skill Definitions” on page 94.

Trace FileName N The name of the Siebel Universal Queuing log file, can 
also further specify the path for it. For example, this 
parameter might be defined as follows:

uqtrace.log

Table 7. Siebel Universal Queuing Configuration Parameters

Parameter Required? Description
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Creating a Universal Queuing Configuration
You create a new Universal Queuing configuration as part of the Siebel Universal 
Queuing configuration process. The configuration is defined using the 
Configurations view in the UQ Administration screen. You can copy an existing 
configuration and modify the necessary parameters for the new configuration as 
well.

To create a configuration

1 From the application-level menu, choose View > Site Map > 
UQ Administration > Configurations.

The Configurations view appears.

2 Create a new record in the Configurations list.

3 Type the name for the new configuration in the Configuration Name field.

Trace Level N Specifies a number that is used internally to decide 
what level of logging will be performed. To have full 
logging information, use 69905. The default is 0—no 
logging is performed.

UQ Host Name Y Identifies Siebel Universal Queuing to the Siebel 
Server.

UQ Host Port Y Identifies the port for Siebel Server to communicate 
with Siebel Universal Queuing.

Use Resonate N If you are using Resonate Central Dispatch, you must 
set this parameter to TRUE. Otherwise, you should set 
it to FALSE. The default is FALSE.

Wrap Enabled N If this parameter is set to TRUE, then the agent will be 
set to Not Ready automatically after completing a 
work item. The default is FALSE.

For more information, see “Agent Availability and 
Sequential Assignment” on page 25.

Table 7. Siebel Universal Queuing Configuration Parameters

Parameter Required? Description
Version 7.5 Siebel Universal Queuing Administration Guide 63



Installing and Running Siebel Universal Queuing

Configuring Siebel Universal Queuing
4 Click the check box in the Primary column if this configuration is to be the 
primary configuration.

As noted earlier in this section, you must designate one configuration as the 
primary configuration. This configuration will be in effect when no 
configuration is otherwise specified.

5 Type a description for this new configuration.

6 Step off the record to save the new configuration.

7 Add new parameters to define this configuration as follows:

a Create a new record in the Parameters list.

b Choose the parameter you want to add from the Name drop-down list.

c Type the value for the parameter in the Value field.

For descriptions of the Siebel Universal Queuing configuration parameters, see 
Table 7 on page 58.

Editing a Configuration
You can edit a configuration by changing one or more of the configuration 
parameters. This might occur because you have changed one or more of the 
optional configuration parameters, such as the maximum number of connections to 
Siebel Server. You change a parameter by editing its record in the Parameters list. 

For descriptions of the Siebel Universal Queuing configuration parameters, see 
Table 7 on page 58.

NOTE: After a configuration parameter value has been changed, agents need to log 
out and log in again to use the changed configuration. If a Skill:skill_name 
configuration parameter was added, then you must use the Notify UQ button before 
the agents log in. For more information, see “Notifying Siebel Universal Queuing of 
Updates” on page 83.

Deleting a Configuration
You can delete a Siebel Universal Queuing configuration when it is no longer 
applicable.
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Defining Channels
Channels are the forms of communication work items that can be routed by Siebel 
Universal Queuing. Examples of channel types include the following:

■ Voice

■ Email

■ Service request

■ Activity

Your implementation of Siebel Universal Queuing can include any communication 
type that can be handled by the underlying communications infrastructure that is 
passing the resulting work item to Siebel Universal Queuing. Siebel Universal 
Queuing can route any work item that contains a channel type and corresponding 
work item characteristics that can be matched to routing rules.

For each channel, you specify a service level. The service level is the desired 
percentage of work items to be routed in a specified period of time. The service level 
is not used in the routing process, but sets a basis for monitoring a route’s 
performance. When the service level for a channel is exceeded, alarms are triggered 
and logged. This allows you to examine the work load for a particular channel in 
real time and make changes to your configurations as necessary.

You should have one channel defined for each channel type. Only one channel can 
be primary at any given time for each channel type. The primary channel is the 
currently active channel for that channel type.

When you find it necessary to change a channel definition, you should add a new 
channel for the channel type and make it primary rather than changing the existing 
channel definition. Historical statistics are gathered and logged based on the current 
channel definition. If you change the channel definition, the historical information 
for that channel type will no longer be valid. 

CAUTION: You should never delete a channel definition unless you understand the 
effect the deletion will have on the historical statistical data that has been logged.
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For each channel, you create channel properties, which are used to define routing 
rules. These properties only need to be defined once. The properties you define here 
are those that appear in the drop-down list for the Property Name field in the 
Properties list, in the Routes view. You will use a subset of these properties to define 
the selection criteria when creating routing rules and a subset of these properties 
will be a part of each work item for this channel.

Channels and channel properties are defined using the Channels view in the 
UQ Administration screen.

To add a channel

1 From the application-level menu, choose View > Site Map > 
UQ Administration >Channels.

The Channels view appears.

2 Choose the channel type from the Channel Type field.

3 Click the check box in the Primary column if this channel is the primary channel 
to be used for this channel type.

4 Type the amount of time (in minutes) in the Service Level (mins) field.

This is the amount of time in which work items in this route are expected to be 
handled. You can use decimals for values less than a minute—for example, 1.5 
minutes equals one minute and thirty seconds.

5 Type the service level percentage in the Service Level Percentage field.

This is the percentage of work items that are expected to be handled within the 
Service Level time.

6 Step off the record to save the new channel.

Modifying Channels
You can change the service level and channel properties for a channel by adding a 
new channel and making the new channel primary.

CAUTION: You should never change an existing channel definition because it will 
affect the validity of the historical data that has been saved based on the existing 
definition. You should never delete a channel unless you understand how the 
deletion will affect the historical data.
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Assigning Employee Skills
Siebel Universal Queuing uses a skills-based algorithm to determine the most 
qualified agent to handle a work item. To be considered a qualified agent by Siebel 
Universal Queuing, an employee must first be defined as an agent in a 
communications configuration. The employee then needs to have skill definitions 
assigned in the UQ Administration screen. 

For more information about defining employee skills, refer to Applications 
Administration Guide.

In the case where more than one agent is qualified to handle a work item, then the 
work item will be assigned to the agent who was least recently assigned a work 
item.

An employee can have many skill definitions. Each skill definition consists of a skill 
identifier (skill ID), a skill value (competency), and a skill expertise value ranging 
from Novice to Expert. A skill identifier can be used multiple times with different 
skill competencies when defining an employee’s skill set. The same skill 
competency can be used for more than one skill identifier. 

For example, an employee could have the following skill definition:

Skill expertise values are always considered to be greater than or equal to. For 
example, a work item requiring a skill expertise of Novice could be handled by an 
agent with a skill expertise of Intermediate or Expert. However, a work item 
requiring a skill expertise of Expert would not be routed to an agent with a skill 
expertise of Intermediate or Novice.

Skill ID Skill Competency Expertise

Spoken_Language English Expert

Spoken_Language Mandarin Chinese Novice

Written_Language English Intermediate
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A predefined list of skill identifiers and allowable skill competencies is loaded each 
time the routing engine is started. These skill identifiers and competencies are lists 
of values created in the Applications Administration screen. Skills are stored in the 
database, using the Skill:skill_name parameter. The skill identifiers and skill 
competencies are data items used by the routing rules to match against work item 
data properties. For more information about this parameter, see Table 7 on page 58.

A virtual agent skill called AgentID is automatically added to an agent’s skill profile 
when the agent logs on. The AgentID value is equal to the agent’s user ID with an 
expertise value of expert. This virtual agent skill can be used just as any other skill 
when defining escalation rules. The purpose of this skill is to simplify routing of 
work items to a specific agent. For information on using the virtual agent skill in 
route escalations, see “Defining a Route Escalation” on page 91.

An agent’s skill profile is made available to Siebel Universal Queuing when that 
agent logs on. The agent’s skill profile can be changed through the UQ 
Administration screen while the agent is logged on by using the Notify UQ button. 
Notify UQ reloads routes and skill definitions. For more information, see “Notifying 
Siebel Universal Queuing of Updates” on page 83.

Employee skills are defined through the Employees view in the UQ Administration 
screen.

To assign a skill to an employee

1 From the application-level menu, choose View > Site Map > 
UQ Administration > Employees.

2 Select the desired employee.

3 From the Skills list, add a new record.

4 Choose a skill category from the Skill drop-down list.

5 From the Employee Competencies list, add a new record.

6 In the Skill field, click the select button.

The Skill dialog box appears.
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7 Choose the specific skill from the list and click OK.

For example, if you chose Product in Step 4 on page 68, then you will see the 
Product drop-down list.

8 Choose the expertise level for the skill.

The following expertise levels are available:

■ Expert

■ Intermediate

■ Novice

9 Save the skill record.

10 If the employee whose skills you have changed is currently logged on to Siebel 
Universal Queuing, click Notify UQ.

Otherwise, the changes will take affect the next time the employee logs on. If 
you have added a new Skill:skill_name configuration parameter, then you must 
use Notify UQ. For more information, see “Notifying Siebel Universal Queuing 
of Updates” on page 83.

11 Continue to add skills in the Employees view, as needed, to create skill profiles 
for employees.

Defining Employee Channel Capacity
You must define the channel capacity for each employee who will receive work 
items from Siebel Universal Queuing. The channel capacity is the number of work 
items for each channel type that can be sent to an employee simultaneously. 

In order for an employee to receive work items for a particular channel, the 
employee must have at least one simultaneous session defined for that channel. If 
channel capacity is not defined for a particular channel, that employee will not be 
considered for work items of that channel type when the routing rules are executed.
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If a channel capacity for an employee is defined for several different channel types, 
then work items for those channel types can be sent to the employee 
simultaneously. For example, if an employee is defined to handle two email sessions 
and one voice call session simultaneously, then that employee could potentially 
receive two email work items and one voice call work item at the same time.

Depending on the type of work item, an employee may have more than one 
simultaneous sessions defined for a channel. This allows the employee to work on 
more than one work item of that type at any given time. However, if you are using 
either of the two approaches to sequential assignment, only one work item will be 
sent to an agent at a time, as long as the simultaneous sessions setting is greater 
than zero.

You use the Simultaneous Sessions list of the Employees view to define an 
employee’s channel capacity.

For more information about sequential assignment, see “Configuring Sequential 
Assignment” on page 73.

To define simultaneous sessions

1 From the application-level menu, choose View > Site Map > 
UQ Administration > Employees.

The Employees view appears.

2 Click the active record indicator for the desired employee.

3 Click the Simultaneous Sessions view tab.

4 In the Simultaneous Sessions list, create a new record.

5 Select the channel type from the Channel Type drop-down list.

6 In the Simultaneous Sessions field, enter the number of simultaneous sessions 
this employee is allowed for this channel type.

The changes will take effect the next time the employee logs on to Siebel 
Universal Queuing.
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Defining Communications Configurations
In order for the Siebel Universal Queuing routing engine to assign an available agent 
to work on certain work items, agents must be assigned to a communications 
configuration (for Siebel Communications Server) that includes Siebel Universal 
Queuing. If a specific Siebel Universal Queuing configuration is not specified, by 
using the UQConfigurationName parameter, then the primary (or default) 
configuration is automatically used. 

The following steps summarize the procedure for configuring Siebel 
Communications Server to work with Siebel Universal Queuing. This procedure 
should be taken as a general outline of the process of setting up a communications 
configuration that will work with Siebel Universal Queuing. 

For complete information about creating or importing a communications 
configuration and about defining elements for this configuration, refer to Siebel 
Communications Server Administration Guide.

Sample communications definitions data and files (.def files) are provided by Siebel 
Systems. The file multichannelA.def corresponds to the sample communications 
configuration named “Multichannel configuration A.” For more information about 
the file callrouteA.def, see “Configuring Sequential Assignment” on page 73.

To configure a call center agent

1 From the application-level menu, choose View > Site Map > Communications 
Administration > All Configurations.

2 In the All Configurations view, add a new configuration. Import configuration 
data from a communications definition file, as appropriate.

3 Click the Parameters view tab.

4 Optionally, in the Parameters list, enter a valid Siebel Universal Queuing 
configuration name as the value for the UQConfigurationName parameter. 

5 Click the Agents view tab.

6 In the Agents list, select a call center agent name.
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7 From the Show drop-down list, choose Agent General Profile.

In the Agent General Profile view, the current record represents the agent you 
specified for the configuration in Step 6.

8 Click the Configurations view tab.

9 In the Configurations list, include the communications configuration name you 
created in Step 2, and mark it as primary for this agent.

10 Click the Telesets view tab.

11 In the Telesets list, choose a teleset for this agent, if the agent will work with 
voice calls and Siebel Universal Queuing is to route voice calls to this agent’s 
teleset extension.
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Configuring Sequential Assignment
As described in “Agent Availability and Sequential Assignment” on page 25, there 
are two ways of enabling sequential assignment for Siebel Universal Queuing:

■ Using the Wrap Enabled configuration parameter

■ Using sequential assignment as defined in the file callrouteA.def

The two sequential assignment options are ways of simplifying work-item handling 
for agents. Use Wrap Enabled = TRUE when agents need time to do wrap-up work 
after releasing a work item.

If you choose not to use either approach, then multiple work items may be assigned 
to an agent at once, subject to each channel’s maximum number of simultaneous 
sessions.

Using the Wrap Enabled Parameter
When the Siebel Universal Queuing configuration parameter Wrap Enabled is set to 
TRUE, agent availability is affected as follows:

■ An agent will receive only one work item at a time.

■ After a work item is released, the agent’s availability is automatically set to not 
ready, for all channels handled by Siebel Universal Queuing.

■ The Change Ready State button on the communications toolbar is enabled, and 
the agent must explicitly set availability to ready—for all channels or for 
individual channels—in order to receive a new work item. (While each work 
item is active, the agent’s state is busy.)

■ The agent receives work items one at a time. Once the agent has accepted a work 
item, the routing engine will not route another work item until the agent finishes 
the current work item and sets availability to ready.

NOTE: For this approach, for each employee, the simultaneous sessions specified for 
each applicable channel must be greater than 0 (zero). For more information, see 
“Simultaneous Sessions” on page 21.
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Using Sequential Assignment as Defined in File callrouteA.def
This second approach to sequential assignment involves certain requirements for 
the communications configuration, which is specified in the Communications 
Administration screen.

In this case, Wrap Enabled can be either FALSE (the default) or TRUE, where agents 
are not required to change their availability state to ready after a call. After a work 
item is released, then, for all channels, an agent’s availability is automatically set to 
ready (when Wrap Enabled = FALSE), or set to not ready (when Wrap Enabled = 
TRUE).

The Change Ready State button on the communications toolbar is enabled, but its 
channel-specific child buttons are disabled. The agent can manually set availability 
to ready, or not ready, for all channels at once.

NOTE: For this approach, for each employee, the simultaneous sessions specified for 
each applicable channel must be 1 (one). For more information, see “Simultaneous 
Sessions” on page 21.

The following scenarios show how agent availability is affected by this second 
option for sequential assignment, whether or not you are also using the first option 
(Wrap Enabled = TRUE). Work items must be manually accepted by an agent. 
Siebel Universal Queuing routes a work item to the agent and places the agent in a 
not ready state for all channels. The following occurs:

■ If the agent accepts the work item, the agent will not receive any more work 
items until the current work item is finished or released—all channels are 
blocked. Upon releasing the work item, the agent is set to a ready state for all 
channels and Siebel Universal Queuing can deliver the next work item to the 
agent—all channels are unblocked. 

(The same is true when Wrap Enabled = TRUE, except that agent availability is 
set to not ready after the work item is released.)
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■ If the agent does not accept the work item (work item assignment timeout is 
reached), Siebel Universal Queuing sets the agent to not ready for all channels, 
and the work item is routed back to Siebel Universal Queuing. The agent must 
manually set availability to ready for all channels. 

(The same is true when Wrap Enabled = TRUE. However, if you are not also 
using the second option for sequential assignment, agents can set availability to 
ready or not ready for all channels, or for individual channels.)

NOTE: The work item assignment timeout is defined by the parameter 
“workitemassigntimeout” in the files vesp.imp and ds.ffd. These files are located 
in the directory install_dir/scomm/uq/etc, where install_dir is the directory into 
which you installed the Siebel Universal Queuing routing engine. The default 
value of 600 seconds (10 minutes) can be modified by an administrator (the 
routing engine must be restarted for this to take effect). With a timeout value of 
600 seconds, if an agent does not accept an incoming work item, after 10 
minutes the routing engine will pull this work item back, set the agent’s 
availability to not ready, and reroute the work item.

Event and Command Definitions for Sequential Assignment
The implementation of the second option for sequential assignment, described in 
“Using Sequential Assignment as Defined in File callrouteA.def” on page 74, is 
mostly handled through the Siebel Communications Server configuration. The 
communications definitions file callrouteA.def, from which event and command 
definitions can be imported, includes definitions that support sequential 
assignment.

For more information about importing configuration data from a file such as 
callrouteA.def, refer to Siebel Communications Server Administration Guide.

In order to use the second option for sequential assignment, you may need to 
change, or verify, your communications configuration. Selected communications 
events and commands in the communications definition file callrouteA.def are 
described in this section. It is important to understand how these definitions work 
so that you can modify them to meet your needs.
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When the file callrouteA.def is prepared appropriately for your needs, you import 
the events and commands from this file into your communications configuration. 
(Alternatively, you may choose to use multichannelA.def, which supports Siebel 
Universal Queuing for the email channel—not the voice channel—but does not 
include event and command definitions that support sequential assignment.)

For more information about working with .def files, about communications events 
and commands, and about special events mentioned in this section, refer to Siebel 
Communications Server Administration Guide.

If you will import definitions from callrouteA.def and do not want to enable the 
second option for sequential assignment, do both of the following before you import 
definitions from the file:

■ Uncomment the lines in “section A” of the file (thereby enabling the channel-
specific child buttons for the Change Ready State toolbar button)

■ Comment out the lines in “section B” of the file (thereby disabling the sequential 
assignment events and commands)

NOTE: When you are using the second method of implementing sequential 
assignment, but you do not want to route work items of all channels to all agents, 
then you must handle this in a special manner. For each applicable agent, you must 
change the simultaneous sessions setting to 0 for a channel to be dropped, as 
described in “Simultaneous Sessions” on page 21. In addition, however, you must 
move all such agents to a separate communications configuration, which should 
support sequential assignment but should not support the dropped channel.
76 Siebel Universal Queuing Administration Guide Version 7.5



Installing and Running Siebel Universal Queuing

Configuring Sequential Assignment
Example Events and Commands for Blocking and Unblocking 
Channels
The following example event and command definitions (from “section B” of 
callrouteA.def) support the second option for sequential assignment. These events 
and commands are for blocking and unblocking other applicable channels after an 
email work item has been started or released. Events and commands for blocking 
and unblocking other channels when the current work item is voice are also 
included in “section B” of callrouteA.def file.

NOTE: In the case of an email work item, blocking of other channels occurs when 
the work item has actually been started, based on the @PreWorkItemStartedEvent 
special event. In the case of a voice work item, however, the special event 
@PreIndicateNewWorkItemEvent is employed; blocking of other channels occurs 
whether or not the voice call has been answered.

The following event definitions are for blocking all other channels (that is, voice) 
after an email work item has been started.

[EventHandler:PreWorkItemStartedEvent_Email]
   DeviceEvent          = "@PreWorkItemStartedEvent"
   Response             = "PreWorkItemStartedEvent_Email"
   Filter.ChannelType   = "Email"
   Order                = "1"

[EventResponse:PreWorkItemStartedEvent_Email]
Command           = "BlockAllUQChannel_Except_Email"

The following command definitions are for blocking all other channels (that is, 
voice) after an email work item has been started.

[Command:BlockAllUQChannel_Except_Email]
   Hidden               = "TRUE"
   ExecuteAll           = "TRUE"
   SubCommand_2         = "CallUQAgentBusy_Voice"

[Command:CallUQAgentBusy_Voice]
   Hidden              = "TRUE"
   DeviceCommand       = "@UQBlockAgentChannel"
   FilterSpec          = 
"[$GetCommandStatus(@UQAgentChangeReadyState(Voice))] = 
'Enabled' OR 
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[$GetCommandStatus(@UQAgentChangeReadyState(Voice))] = 
'Checked'"
   CmdData             = "CallUQAgentBusy_Voice"

[CmdData:CallUQAgentBusy_Voice]
Param.MediaType  = "Voice"

The following event definitions are for unblocking all other channels (that is, voice) 
after an email work item has been released.

[EventHandler:WorkItemReleasedEvent_Email]
   DeviceEvent = "@PreWorkItemReleasedEvent"
   Response    = "WorkItemReleasedEvent_Email"
   FilterSpec = "[$GetWorkItemAttr(WorkItemID, IsRevoked)] = 
'FALSE'"
   Filter.ChannelType = "Email"
   Order              = "1"

[EventResponse:WorkItemReleasedEvent_Email]
Command         = "UnBlockAllUQChannel_Except_Email"

The following command definitions are for unblocking all other channels (that is, 
voice) after an email work item has been released.

[Command:UnBlockAllUQChannel_Except_Email]
   Hidden               = "TRUE"
   ExecuteAll           = "TRUE"
   SubCommand_2         = "CallUQAgentAvailable_Voice"

[Command:CallUQAgentAvailable_Voice]
   Hidden              = "TRUE"
   DeviceCommand       = "@UQUnBlockAgentChannel"
   FilterSpec          = 
"[$GetCommandStatus(@UQAgentChangeReadyState(Voice))] = 
'Enabled' OR 
[$GetCommandStatus(@UQAgentChangeReadyState(Voice))] = 
'Checked'"
   CmdData             = "CallUQAgentAvailable_Voice"

[CmdData:CallUQAgentAvailable_Voice]
Param.MediaType   = "Voice"
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Configuring Session Timeout for EAI Object Manager
When a connection to the Siebel EAI Object Manager is idle for a period of time, the 
EAI Object Manager will disconnect the session. The Siebel Universal Queuing 
business service will not know that this session cannot be used. As a result, no work 
items will be delivered to agents, the Siebel Universal Queuing connection will have 
to be reset, and all agents will be logged out and will have to log back in.

To avoid this problem, a reasonable session timeout (in seconds) must be specified 
in the eapps.cfg file on the Web server. For example, if the eapps.cfg file reads:

[/eai]
ConnectString = connect_string
EnableExtServiceOnly = TRUE

Change the file to read:

[/eai]
SessionTimeout = 28800
ConnectString = connect_string
EnableExtServiceOnly = TRUE
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This chapter describes how to define routes and escalations, and describes various 
operations that agents and administrators may perform to handle work items and 
manage the system. 

You must define routes and escalations before you can deploy Siebel Universal 
Queuing.

Also refer to related Siebel documentation for your products, such as Siebel 
Communications Server Administration Guide and Siebel eMail Response 
Administration Guide.
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Creating Routes and Escalations
Setting up Siebel Universal Queuing primarily involves defining routes that are used 
to direct work items to the appropriate agent for handling. When defining routes, 
you need to take into consideration the type of work item (channel), the 
characteristics of the work item (for example, is this a high-priority customer), and 
the best person to handle the work item (employee, skill, and competency).

Routing a work item in Siebel Universal Queuing is a two-step process:

■ First, the work item is matched to a route based on selection criteria.

■ Second, an appropriate agent is located to handle the work item based on a skill 
set defined in the selected route’s escalation steps.

You define the routing rules that contain the business logic to accomplish these two 
steps.

NOTE: Escalation steps consider agent availability only for real-time work items.

Selection criteria are made up of simple to complex statements that Siebel Universal 
Queuing evaluates based on the properties of a work item. Generally, the more 
complex the statements, the better job Siebel Universal Queuing can do in assigning 
work items in accordance with your company’s business rules.

For more information, see “Defining Routes, Route Properties, and Escalation 
Rules” on page 84.

Escalation steps determine how a work item is going to be routed based on a set of 
skill definitions and wait times. Skill definitions are used to match a work item with 
an employee who holds the same skill definitions. Each route typically contains a 
series of escalation steps; each step becoming more liberal in the skill requirements, 
so that the last escalation step will include the largest pool of available employees. 
For more information, see “Defining a Route Escalation” on page 91.
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When a qualified employee for a work item is not available, the work item remains 
in the route until an employee becomes available. If the wait time for a route 
escalation is exceeded, the work item moves to the next escalation rule, usually 
with a more liberal set of employee skills. If the last escalation rule is reached, and 
the work item remains unassigned in the route longer than the wait time, an alarm 
is triggered and logged. For more information on alarms, see “Viewing Alarms and 
Errors” on page 104.

Each channel should have a catch-all route defined so that any poorly defined work 
items will find a matching route. Otherwise, a work item may go through the routing 
engine without being routed. In this case, an alarm is sent to Siebel Server but the 
work item will not be processed.

Notifying Siebel Universal Queuing of Updates
Routing rules and escalations are loaded from the database when the Siebel 
Universal Queuing routing engine is started. When you make changes to routing 
rules and escalations, you might not want to have to restart the routing engine in 
order to load the new rules. The Notify UQ button on the Routes view in the UQ 
Administration screen allows you to reload the routing rules and escalations while 
the routing engine is running. 

NOTE: Notify UQ does not reload the setting of the Non Real-Time flag for a route. 
This setting should not be changed for a route during runtime.

When you click Notify UQ, all routes, route properties, and escalations are reloaded, 
not just those you have changed.

Notify UQ is especially useful when you change the characteristics of an existing 
route or add a new route. You can also use Notify UQ after deleting a route; the route 
is deleted after the last work item is routed to an agent. Once a route is loaded (or 
reloaded) into the routing engine, the route remains until the next restart of the 
system.
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Defining Routes, Route Properties, and Escalation Rules
Work items are handled according to business logic expressed as routing rules. A 
routing rule has these components:

■ Route record

■ Route properties, described in “Adding Route Properties” on page 86

■ Route escalations and escalation rules, described in “Defining a Route 
Escalation” on page 91

A route is specific to a particular channel. However, a channel can have many 
routes. For example, an email channel could have a route for email messages 
directed to a technical support email address as well as a route for general email 
messages. However, each of these routes can only apply to a channel type of email.

When creating routes, follow these guidelines:

■ Always include a general route for each channel type with the lowest priority 
setting. This general route will catch work items for the channel that do not 
match any other route for the channel.

■ Always define the last escalation step for a route to include the entire pool of 
possible agents and define the wait time as zero. This will make sure that work 
items will always be assigned to an agent at some point in the route escalation.

Each route depends on the selection criteria defined in its route properties to 
evaluate work items for routing.

A route property is a set of key-value pair criteria, which are compared to the work 
item’s data property key-value pairs. When a new work item is sent to Siebel 
Universal Queuing, the routes and route properties for the applicable channel type 
are searched to find a route whose properties match the work item. The first route 
for which selection criteria key-value pairs match the key-value pairs of the work 
item becomes the selected route for that work item. 

Routes are selected only once—when the work item is introduced into the system. 
Every work item is associated with just one selected route.
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Each route has a Priority field. Routes are searched for a matching selection rule in 
priority order, from highest to lowest integer value. The priority determines the 
order in which routes are matched to work items, and the order in which work items 
are assigned to agents. If work items in two or more routes match an agent’s skill 
profile, the work item with the highest priority is routed to the agent first.

In the example above, where you have one email route for technical support and 
one email route for other inbound email messages, you might assign a priority of 
“10” to the technical support route and a priority of “2” to the general email route. 
An email addressed to support@yourcompany.com would actually match both 
routes. However, by setting the technical support route to a higher priority, this 
route will be matched to the email message first. The message will be routed to an 
agent who can handle technical support questions.

To create a route

1 From the application-level menu, choose View > Site Map > 
UQ Administration > Routes.

The Routes view appears.

2 Type the name for this route in the Name field.

3 Choose the channel type from the Channel Type drop-down list.

4 Select a priority for this route from the Priority drop-down list.

NOTE: The higher the priority number, the higher the priority.

5 Type the maximum number of work items you would like to see waiting in this 
route in the Capacity field.

The capacity for a route is an arbitrary number that you will use to gauge the 
activity level of a route. When the number of work items in a route at any given 
time exceeds the capacity you have set, an alarm is triggered and logged. If you 
frequently exceed the capacity of a route, you may want to evaluate the design 
of the routing rule logic to make sure it is meeting your needs.

6 Click the Active check box to make this route active.
Version 7.5 Siebel Universal Queuing Administration Guide 85



Using Siebel Universal Queuing

Creating Routes and Escalations
7 Click the Non Real-Time check box to have work items for this route assigned 
to an employee regardless of the employee’s availability.

Nonreal-time work items are assigned to an employee whether or not the 
employee is ready to accept work items. The work item will be placed into the 
appropriate queue for the employee, such as My Service Requests, My Activities, 
or My Communications.

CAUTION: Do not change the setting of the Non Real-Time check box in real-time.

8 Type the amount of time (in minutes) in the Service Level (mins) field.

The service level is the amount of time in which work items in this route are 
expected to be handled. This number is not used in the routing process but sets 
a target for monitoring performance. You can use decimals for values less than 
a minute—for example, 1.5 minutes equals one minute and thirty seconds.

9 Type the service level percentage in the Service Level Percentage field.

This is the percentage of work items that you want to have handled within the 
Service Level time.

10 Step off the record to save the new route.

Adding Route Properties
After you define a route, you add one or more property statements to the route. 
Route properties contain properties that match a work item to the channel for the 
route, and contain selection criteria, based on these properties, that match the work 
item to the specific route.

For example, an email channel with a channel property of RecipientAddress might 
be defined in a route as follows:

Property Name RecipientAddress

Relation =

Property Value support@yourcompany.com
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In the preceding example, email messages sent to support@yourcompany.com 
would match this route.

To add route properties

1 From the application-level menu, choose View > Site Map > 
UQ Administration > Routes.

The Routes view appears.

2 Select the route for which you are adding properties.

3 In the Properties list, add a new record.

4 Complete the route property fields shown in Table 8.

Table 8. Route Property Fields

Field Description

Begin Group Optional. When multiple route properties are defined and joined to specify complex 
selection criteria, you may need to begin the definition of an individual route property 
with ( or ((, as is appropriate for its role in the overall selection criteria defined by the 
joined individual route properties.

You do not need to select a value for a route with only a single route property.

Property Name Required. Choose one of the properties from the drop-down list.

Note: The route properties you can specify here were initially defined as channel 
properties, in the Properties list of the Channels view.

Relation Required. The valid relational operators are as follows:

< less than

<= less than or equal

= equal to

> greater than

>= greater than or equal

~ wildcard match
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Using Regular Expressions for Route Properties
A route property is evaluated using one of the standard relational operators. The 
operator = can be followed by a text string or a numeric value. The operators >, 
<, ≥, and ≤ must be followed by a numeric value. A route property can also be 
defined by using a wildcard character (~) followed by a UNIX-style regular 
expression. The elements shown in Table 9 can be used to build the expression.

Property Value The value match for this property. For example, ENU is the property value in the 
statement Language Code=“ENU”.

The ~ wildcard match can be used with the following values:

* – 0 or more characters

? – one single character

. (period) – one or more occurrences of the previous character

End Group Optional. When multiple route properties are defined and joined to specify complex 
selection criteria, you may need to end the definition of an individual route property 
with ) or )), as is appropriate for its role in the overall selection criteria defined by the 
joined individual route properties.

You do not need to select a value for a route with only a single route property.

Join Required for more than one property statement. The possible join values are AND and 
OR.

Sequence Required. The sequence in which property statements are evaluated for this route. If 
only one statement is entered, the sequence is “1”.

Table 8. Route Property Fields

Field Description

Table 9. Regular Expression Elements for Route Properties

Regular Expression Element Description and Example

^ Match any string at the beginning of the line. For example:

A property value of ^650 selects any number with 650 as the first three digits.

+ Match one or more of the preceding characters. For example:

A property value of ^6503+ selects numbers with the area code 650 and a 
prefix beginning with a 3. The value will also select numbers where the 650 
series exists after the area code, such as 415-336-5033.
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Defining Multiple Route Properties
You can define multiple route properties for a given route to further refine the work 
items selected for the route. When you define more than one route property, you 
must specify a logical operator (AND or OR) for the Join field in order to join a route 
property to the next route property (next highest Sequence value).

■ Use AND to indicate that both route properties must be met for a work item to 
match the route.

■ Use OR to indicate that either of the route properties can be met for a work item 
to match the route.

. (period) One single character. For example:

A property value of ^6503…… selects ten-digit phone numbers with the area 
code 650 and a prefix beginning with a 3. You must have a period in place of 
each of the remaining numbers.

* Match zero or more occurrences of the preceding character. For example:

A property value of ^6503* selects numbers with the area code 650, any prefix 
(zero or more occurrences of the character just before the *), and any number 
of characters after the 3.

? Match zero or one occurrence of the preceding character. For example:

A property value of ̂ 6503? selects any phone number with an area code of 650, 
unless the prefix begins with the digit 3 repeated once (two instances).

[ ] Match any value within the range between the brackets. For example:

A property value of [A-Z][a-z] selects any capitalized word.

$ Match any string at the end of a line. For example:

A property value of 1234$ selects any number that ends with “1234”.

? Match zero or one occurrence of the preceding character. For example:

A property value of ̂ 6503? selects any phone number with an area code of 650, 
unless the prefix begins with the digit 3 repeated once (two instances).

Table 9. Regular Expression Elements for Route Properties

Regular Expression Element Description and Example
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When you have multiple route properties, you must also set the sequence in the 
Sequence field. The sequence number is an aid to help you insert and order route 
property expressions as you create and modify the route. When you sort the route 
properties by sequence number, you can see the order in which the route property 
expressions will be evaluated.

Route Property Syntax
The syntax for a route property is as follows:

property_name comparison_operator constant_string 
logical_operator sequence

or

property_name ~ regular_expression logical_operator sequence

The syntax defined above allows you to describe complex routing rules. Examples 
are shown below.

The following set of route properties (shown in sequence) matches a work item 
when the account number is at least 100,000 but less than 200,000 or the account 
number is at least 500,000 but less than 600,000, and where the requested product 
type is either Bond, Tbill, or Annuity:

(AcctNum >= "100000" & 
AcctNum < "200000") | 
(AcctNum >= "500000" & 
AcctNum < "600000") & 
(Product = "Bond" | 
Product = "Tbill" | 
Product = "Annuity")

The following set of route properties (shown in sequence) matches a work item 
when the account number is at least 100,000 but less than 200,000, or where the 
account number is at least 500,000 but less than 600,000 and where the requested 
product type is either Bond, Tbill, or Annuity:

(AcctNum >= "100000" & 
AcctNum < "200000") | 
((AcctNum >= "500000" & 
AcctNum < "600000") & 
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(Product = "Bond" | 
Product = "Tbill" | 
Product = "Annuity"))

Defining a Route Escalation
Once a route is selected for a work item based on its route properties, the escalation 
component of the rule determines how the work item is routed. Every route must 
have one or more escalation steps. Each escalation step consists of one or more skill 
requirements and a wait time.

Siebel Universal Queuing will attempt to find a suitable agent for the work item 
based on the first escalation step (or set of skill requirements). If a suitable agent 
cannot be found to handle the work item before the escalation step’s wait time has 
elapsed, then the next escalation step will be evaluated. If you enter 0 as the wait 
time, the work item will remain in this escalation step until an agent becomes 
available.

When the wait time for the last escalation step in a route expires, a warning alarm 
is generated and logged. Therefore, the last escalation step should have skill 
requirements that are general enough to handle any work items for this route. 

To create a route escalation

1 From the application-level menu, choose View > Site Map > 
UQ Administration > Routes.

The Routes view appears.

2 Select the route for which you are adding an escalation.

3 Click the Escalations view tab.

The Escalations list appears.

4 Type a name for the escalation in the Escalation Name field.

5 Type the number of minutes in the Time Out field.

This is the number of minutes to wait for an available agent. If no available agent 
is found within this time, the next escalation is applied. 
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6 Type a number in the Order field representing the order in which this escalation 
is to be applied.

NOTE: The order number specified for each escalation must be unique in order 
to guarantee that all escalations are applied in the intended sequence.

7 Create escalation rules, as described in “Creating Route Escalation Rules” on 
page 92.

Creating Route Escalation Rules
This section describes how to create escalation rules and describes the syntax and 
fields for escalation rules. Escalation rules are based on skill definitions, which are 
described in “Creating Skill Definitions” on page 94.

NOTE: Escalation rules do not need to be entered in the order of evaluation. 
However, entering the rules in the order in which you want them to execute will 
help you to visually understand the evaluation sequence. You can sort on the 
Sequence field afterwards, regardless of the order in which you created the rules.

To create an escalation rule

1 From the application-level menu, choose View > Site Map > 
UQ Administration > Routes.

The Routes view appears.

2 Select the route for which you are adding an escalation.

3 Click the Escalations view tab.

4 Select the escalation for which you are adding an escalation rule.

5 Add escalation rules to the route as follows:

a In the Escalation Rules view, add a new record.

The Escalation Rules form appears.

b Complete the escalation rule fields.
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6 Click Notify UQ if you want to reload the routing rules without restarting Siebel 
Universal Queuing.

Otherwise, the new rules will take effect the next time Siebel Universal Queuing 
is started.

Route Escalation Rule Syntax
The syntax for an escalation rule is as follows:

skill_id = skill_value/expertise

where skill_value is either a constant string or a data property name.

The following example shows an escalation rule that looks for an agent who is 
expert in the product, or an agent who is intermediate in the product, but has had 
advanced training, or a universal agent who is also licensed in the customer’s state.

This example uses data property substitution, where Product is the name of a data 
property.

(ProdSkill = "%Product%"/3) | 
(ProdSkill = "%Product%"/2 & 
TrainingLevel = "Advanced") | 
(ProdSkill = "Universal"/3 & 
License = "%state%")

Fields for Route Escalation Rules
Escalation rule fields are described in Table 10.

Table 10. Escalation Rule Fields

Field Comment

Begin Group Optional. When multiple escalation rules are defined and joined to specify complex 
selection criteria, you may need to begin the definition of an individual escalation rule with 
( or ((, as is appropriate for its role in the overall selection criteria defined by the joined 
individual escalation rules.

You do not need to select a value for a route with only a single escalation rule.

Skill Name Required. Choose from the pop-up window.
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Creating Skill Definitions
An escalation rule consists of a set of skills that are required to handle this work 
item. A skill is defined by the skill name, a skill value, and a skill expertise level.

Skill names and values are defined by your Siebel administrator. These skill names 
and values are included as data properties for a work item. They are then used to 
match a work item with employees who have the same skill definition. 

The skill names are defined as instances of the Skill:skill_name configuration 
parameter in the Configurations view in the UQ Administration screen. For more 
information, see “Defining Configurations” on page 57 and “Assigning Employee 
Skills” on page 67.

Skill Item Required. Choose from the pop-up window or enter the name of a work item data property. 
The value of the data property will be used when the rule is evaluated.

Expertise Required. Choose one of the following values from the drop-down list:

■ Novice

■ Intermediate

■ Expert

If no expertise value is selected, a default value of Novice is used.

End Group Optional. When multiple escalation rules are defined and joined to specify complex 
selection criteria, you may need to end the definition of an individual escalation rule with 
) or )), as is appropriate for its role in the overall selection criteria defined by the joined 
individual escalation rules.

You do not need to select a value for a route with only a single escalation rule.

Join Required for more than one rule statement. The possible join values are AND and OR.

Sequence Required. The sequence in which escalation steps are evaluated for this route rule. 

If only one escalation step is entered, the sequence is 1. As you add new escalation steps, 
the sequence number is automatically assigned using the highest sequence number used 
plus one. For example, if you have sequence number 3, 6, and 8 already defined and you 
add a new step, the sequence number 9 is automatically assigned to the new step.

Table 10. Escalation Rule Fields

Field Comment
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In many cases, each employee has already been assigned a set of skill definitions. 
For details, refer to Applications Administration Guide. However, you can also 
assign skill definitions for an employee through the UQ Administration screen. For 
more information, see “Assigning Employee Skills” on page 67.

Skill values may be explicitly specified in the escalation step, or may be indirectly 
defined by specifying a work item data property name. If you substitute a skill value 
with a data property name enclosed in % characters, the value of that data property 
for a given work item will be used for the skill value. Enclosing the data property 
name in % characters triggers the data property substitution behavior.

For example, you could define a data property alternatively as Product = “Solaris” 
or as Product = “%system%”, where the value of the Product data property is not 
fixed but takes on the value of system from the work item. Using data property 
substitution allows you to use the route and escalation more flexibly, such as, as in 
this example, for more than one operating system.

To simplify the routing of a work item to a particular agent, a virtual agent skill 
called AgentID is automatically added to an agent’s skill profile when the agent logs 
on. The AgentID value is equal to the agent’s user ID with an expertise value of 
expert. This virtual agent skill can be used just as any other skill when escalation 
rules are defined.

You use the virtual agent skill in the same way you specify a skill value using a data 
property name. The skill ID is always AgentID. The skill value data property name 
can be anything as long as the value contained in the work item equals the agent’s 
user ID. For example, AgentID = “%cust_rep_ID%” would match a work item data 
property called cust_rep_ID where the value was the agent’s user ID.

Skill expertise levels are defined by your Siebel administrator. Each employee has 
been assigned an expertise level for each of their skill definitions. You can assign an 
expertise level of Novice, Intermediate, or Expert. If no expertise level is assigned, 
Novice is used as a default.

NOTE: Each sequential escalation step within a routing rule should relax the skill 
requirements, so that a larger number of agents will be eligible to handle the work 
item. The last escalation step of a routing rule should include as large a pool of 
agents as possible.
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Editing a Route Definition in Real-Time
You can edit a route definition at any time by making the necessary changes using 
the Routes view in the UQ Administration screen. The changed route definition will 
take effect the next time the rules are loaded. 

You can use the Notify UQ button on the Routes view to load the routing rules while 
the system in running. Using Notify UQ reloads all of the rules, not just those that 
you changed. You can also reload the rules by restarting the routing engine.

Inactivating a Route Definition
If you no longer need a route, it is advisable to inactivate the route rather than to 
delete it. Do not delete a route unless you understand the effect the deletion will 
have on the historical statistical data that has been logged.

To make a route definition inactive, uncheck the Active flag for the route in the 
Routes view of the UQ Administration screen.

After you inactivate, use the Notify UQ button. The change will take effect after the 
last applicable work item has been routed to an agent.
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Receiving and Handling Work Items
Call center agents use the communications toolbar to log into Siebel Universal 
Queuing and to handle work items dispatched by the routing engine. The following 
list summarizes the functions related to work items that agents can perform from 
the communications toolbar.

■ Login. Allows you to log into or out of a communications system, such as Siebel 
Universal Queuing. Agents should log into Siebel Universal Queuing only once 
per session.

■ Accept Work Item. Allows you to accept an inbound voice call, an email message, 
or a work item of another channel type. When an inbound work item is routed 
to you, the Accept Work Item button blinks.

■ Release Work Item. Allows you to release or disconnect the active work item. 

■ Blind Transfer. Allows you to perform a one-step transfer of a work item such as 
a voice call.

■ Consultative Transfer. Allows you to initiate, and to complete, a two-step transfer 
of a voice call.

■ Pause Work Item. Allows you to pause the active work item, such as to put a voice 
call on hold.

■ Work items list. Allows you to select a paused work item on which to resume 
work.

■ Resume Work Item. Allows you to resume work on a paused work item selected 
from the work items list.

■ Change Ready State. Allows you to indicate that you are unavailable to accept 
work items (Not Ready state) or that you are available again (Ready state). 
Depending on your configuration, you can choose to change your ready state for 
all channels or for selected individual channels.

The communications toolbar and functions listed above are discussed in more detail 
in Siebel Communications Server Administration Guide.
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In addition to the functions listed above, call center agents configured to use Siebel 
Universal Queuing can also use the following functions:

■ Transfer to Route. Allows you to transfer a work item to a different route. For more 
information, see “Transferring Work Items to Another Route” on page 98.

■ My Qualified Work Items. Allows you to select from a list of work items waiting to 
be handled by an employee matching your skill qualifications. For more 
information, see “Selecting Work Items from My Qualified Work Items View” on 
page 99.

Transferring Work Items to Another Route
In addition to transferring a work item to another call center agent, you can transfer 
an inappropriately routed work item to a route that can better handle the request. 
When you transfer a work item to another route, the selection criteria of the new 
route is bypassed and the work item is processed through the escalation steps as 
appropriate.

Transfer to route can also be used if an agent receives a work item because a more 
qualified agent was not available and the work item progressed through the 
escalation steps. In this case, if the work item could better be handled by a more 
qualified agent, the work item can be transferred back to the same route. However, 
if a more qualified agent is still not available, the work item could be reassigned to 
the transferring agent.

The routes to which you can transfer a work item are automatically generated based 
on the routes defined by the administrator.

The Transfer to Route command is accessed by using the Blind Transfer button on 
the communications toolbar. This button is configured, by default, to transfer work 
items to a route, in addition to performing other blind transfer operations. 
Alternatively, administrators can create a separate button on the communications 
toolbar, or configure a communications menu command, by which agents can 
access the Transfer to Route function.

Communications commands to transfer a work item to a route must specify the 
special command @UQTransferWorkItemToRoute as the device command.
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For more information about special commands, command configuration, and 
communications toolbar and menu configuration, refer to Siebel Communications 
Server Administration Guide.

To transfer a work item to another route

1 Select the work item you want to transfer to another route.

2 From the communications toolbar, click Blind Transfer.

A list of routes appears.

3 Click the route to which you want to transfer the selected work item.

The work item is placed in the route specified and routed to the next available agent 
based on the escalation steps.

Selecting Work Items from My Qualified Work Items View
Agents have the option of selecting work items from a list of work items matching 
their skill set that are waiting to be handled. The agent uses the My Qualified Work 
Items view in the Communications screen for this purpose.

To select a work item

1 From the application-level menu, choose View > Site Map > 
Communications > My Qualified Work Items.

The My Qualified Work Items view appears.

2 Click the Change Ready State button on the communications toolbar to change 
availability to ready, if necessary.

3 Click Request Work Items to display the available work items.

A dialog box appears, prompting you for the number of work items for Siebel 
Universal Queuing to display.
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4 Enter the number of work items you want to see and click OK.

NOTE: The number you specify here will be the maximum number of work items 
you can receive for each channel; normal limits on channel capacity may be 
overridden. For example, if you are enabled for the voice and email channels, 
and you specify to receive two work items, you may receive up to two work 
items of the voice channel and two work items of the email channel—even if the 
specified maximum for either of these channels is less than two.

If you do not enter a number, the default display in the My Qualified Work Items 
list in the Communications screen is up to 10 work items.

5 Select a work item you decide to work on and click Request Assignment.

6 Click Accept to accept the work item.

Routing Service Requests or Activities
The Route With UQ command allows a customer to have Siebel Universal Queuing 
route an open service request or unassigned activity to an agent with the 
appropriate skills. After the command is issued, the status of the record is changed 
and the service request or activity will be matched to a route and sent to Siebel 
Server for routing to the next available agent. Siebel Server changes the ownership 
of the record to the newly assigned agent.

Service request and activity work items are typically nonreal-time, and are accessed 
by the recipient agent in the My Service Requests view or My Activities view, as 
appropriate. No visual aid alerts the agent to the new work item, as with a real-time 
work item that arrives by way of the communications toolbar.

By default, only service requests with the Status field set to Open can be routed 
using Siebel Universal Queuing. After a service request has been sent to the routing 
engine, the status of the service request changes to Pending, and the Substatus field 
is set to Assigned.

By default, only activities with the Status field set to Unassigned can be routed using 
Siebel Universal Queuing. After an activity has been sent to the routing engine, the 
status of the activity changes to In Progress.
100 Siebel Universal Queuing Administration Guide Version 7.5



Using Siebel Universal Queuing

Receiving and Handling Work Items
To route a service request or activity with Siebel Universal Queuing

1 From the application-level menu, choose View > Site Map > Service Requests, 
or choose View > Site Map > Activities.

The My Service Requests view, or the My Activities view, appears.

2 Click the More Info view tab.

3 In the More Info form, click the menu button, and then choose Route With UQ.

The service request or activity is routed by Siebel Universal Queuing to the next 
available agent with the appropriate skills to handle the work item.

Routing an Email Message as a Nonreal-Time Work Item
Email messages are normally routed in real-time, but you can alternatively 
configure communications events to allow agents to route them as nonreal-time 
work items—in the same manner that an agent can use the Route With UQ function 
to route a service request or an activity, as described earlier in this section.

To support this capability, define events like the following in the communications 
configuration:

[EventHandler:HandleNonRealTimeEmail]
   DeviceEvent = "@HandleNonRealTimeWorkItem"
   Filter.MediaType = "Email"
   Response = "HandleNonRealTimeEmail"
   Order = "55"

[EventResponse:HandleNonRealTimeEmail]
   QueryBusObj = "eMail Response"
   QueryBusComp = "Action"
   QuerySpec = "Id = '{ActivityID}'"
   SingleField.'Primary Owned By' = "{@UserName}"

The event response in this example sets the value of the “Primary Owned By” field 
for the email message’s activity record to the user name of the assigned agent.

For more information about communications events and about the 
@HandleNonRealTimeWorkItem special event, refer to Siebel Communications 
Server Administration Guide.
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Abandoning a Phantom Work Item
If a system administrator determines that a given work item is a phantom and no 
longer corresponds to a real work item, the administrator can request that Siebel 
Universal Queuing abandon the work item.

For example, in some cases, a phone call may be abandoned on the phone switch, 
but may still exist in Siebel Universal Queuing. Such a work item may be assigned 
to an agent, but the agent may not be notified through the communications toolbar. 
After a timeout, the work item would then return to Siebel Universal Queuing, 
which puts the agent into auxwork mode and stops routing work items to the agent. 
The work item could later be reassigned all over again. Abandoning this phantom 
work item removes it from the queuing system.

For more information about alarms and errors, see “Viewing Alarms and Errors” on 
page 104.

To abandon a phantom work item

1 From the application-level menu, choose View > Site Map > 
UQ Administration > Alarms and Errors.

The Alarms and Errors view appears.

2 In the Alarms and Errors list, query for work item records where the value of the 
Code field is “32.”

3 With such a phantom work item selected, click Abandon Work Item to abandon 
this work item.

Resetting the Siebel Universal Queuing Connection
When a system administrator determines that work items are waiting in the system 
but not being delivered to agents, the administrator can choose to reset the Siebel 
Universal Queuing connection to Siebel Server. Before choosing this option, the 
system administrator should make sure that the situation is systemwide and not just 
affecting a few agents.

The system administrator should also consider extending the SessionTimeout 
parameter for the Siebel EAI Object Manager. For more information, see 
“Configuring Session Timeout for EAI Object Manager” on page 79.

For more information about alarms and errors, see “Viewing Alarms and Errors” on 
page 104.
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To reset the Siebel Universal Queuing connection

1 Ask your agents to finish all open work items and log out as quickly as possible.

2 From the application-level menu, choose View > Site Map > 
UQ Administration > Alarms and Errors.

3 In the Alarms and Errors list, click the menu button, and then choose 
UQ Connection Reset.

4 Ask your agents to log back in.

Resetting the Siebel Universal Queuing Agent Session
When the Siebel application is not responding to an agent’s communications 
activity (such as when the agent cannot change ready state or log out), the agent 
should contact the system administrator for assistance in resolving the problem. 

If the system administrator has determined that one of the following problems exist, 
the agent should reset the Universal Queuing session, as described below:

■ Agent was unable to complete a work item.

■ Agent was unable to accept a new work item or had no incoming work items.

■ Agent was unable to change state to ready or not ready.

■ Agent was unable to log in or log out.

To reset the Siebel Universal Queuing session (performed by agent)

1 Request assistance from the system administrator in determining the problem.

2 From the application-level menu, choose View > Communications > Reset > 
UQ Agent Reset.

The agent is logged out from Siebel Universal Queuing. All real-time work items 
associated with this agent are abandoned, such as voice calls. All nonreal-time 
work items associated with this agent are rerouted to the next available agent. 
The agent can now log back in.

3 Close the Web browser.

4 Restart the Siebel application and log in.
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Viewing Alarms and Errors
Siebel Universal Queuing generates alarm and error messages and logs them to the 
database. Alarms and error messages can be viewed using the Alarms and Errors 
view in the UQ Administration screen. In addition, you can create workflow policies 
that monitor the messages and that email specific types of messages to a designated 
email account within your organization.

Alarms are classified using the following designations and criteria:

■ Informational. Events requiring no action or intervention, such as reporting 
initialization progress.

■ Warning. Events that require action, but not necessarily immediate action. There 
is no immediate degradation in system capabilities or performance. Examples 
include memory utilization hitting a predetermined threshold, or number of 
users approaching the system limits.

■ Critical. Immediate action is required, and the system capability is degraded. An 
example is a missing required parameter on an API method, or inability to 
continue to write log information.

■ Emergency. Immediate action is required, and the system may fail to perform in 
a useful manner. An example is the inability to connect to the database.

For more information about addressing error conditions, see Chapter 6, 
“Troubleshooting Siebel Universal Queuing.”

To view alarms and errors

1 From the application-level menu, choose View > Site Map > 
UQ Administration > Alarms and Errors.

The Alarms and Errors view appears, displaying all current alarm and error 
messages.

2 Click Query.

The Enter Query form appears.

3 Enter a value for one of the fields and click Go.

The data matching the value entered appears in the Alarms and Errors list.
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This chapter describes the real-time and historical statistics that are provided by 
Siebel Universal Queuing. It also describes the Siebel Universal Queuing business 
objects and business components that must be referenced by any custom reporting 
implementation.
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Viewing Real-Time Status Data
You can display real-time status data about channels, employees, and routes 
currently active in Siebel Universal Queuing. 

This section describes how to display real-time status data for channels, employees, 
and routes. For information on historical data, see “Viewing Historical Data” on 
page 110.

Setting the Refresh Interval
The refresh interval determines how often real-time statistics are gathered and 
logged. For example, if you set the refresh interval to 30 minutes, statistics are 
gathered every 30 minutes. When you click the Refresh button in the Channel 
Statistics or Route Statistics view, real-time statistics are displayed in 30-minute 
increments. The minimum refresh interval is one minute.

To set the refresh interval

1 From the application-level menu, choose View > Site Map > 
UQ Administration > Channel Statistics or Route Statistics.

2 Click Set Refresh Interval.

The Set Refresh Interval dialog box appears.

3 Type the number of minutes in which to gather the data and click OK.

The minimum value is one minute.

Viewing Channel Status Data
The Channel Statistics view displays the following for each channel type:

■ The target and actual service level

■ The average wait time and the longest wait time

■ The total number of abandoned work items

■ The total number of work items for a particular channel type
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To view channel statistics data

1 From the application-level menu, choose View > Site Map > 
UQ Administration > Channel Statistics.

The Channel Statistics view appears.

2 Click Refresh to display the data.

NOTE: The data is not automatically refreshed when the view appears. You must 
click Refresh to display the data.

Viewing Employee Status Data
The Employee Statistics view comprises the following three lists:

■ Employee Statistics

■ Channel Summary (child list)

■ Details (child list)

Viewing Channel Summary Statistics by Employee
The Channel Summary list displays the following statistics by channel for a selected 
employee:

■ Log in and log out times.

■ Average time it took to handle a work item.

■ Number of work items handled.

To view channel summary statistics by employee

1 From the application-level menu, choose View > Site Map > 
UQ Administration > Employee Statistics.

The Employee Statistics view appears.

2 Select an employee in the Employee list.

The summary statistics by channel for the selected employee appear in the 
Channel Summary list.
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Viewing Detailed Employee Statistics
The Details list displays the following statistics for a selected employee by channel:

■ Start and end times

■ Percentage of time the employee was idle

■ Number of work items

■ Total time spent working on work items

■ Total wrap time

■ Total number of times in not ready state

Employee details are not gathered automatically. You must start and stop the 
gathering of statistics, as described in the procedure below.

To view detailed employee statistics

1 From the application-level menu, choose View > Site Map > 
UQ Administration > Employee Statistics.

2 Click the Details tab.

3 Click Start Statistics to begin capturing data for this employee.

The Set Refresh Interval dialog box appears.

4 Type the number of minutes in which to gather the data and click OK.

The minimum value is one minute.

5 Click Refresh to display the statistics for this employee.

The statistics for this employee are displayed for each time interval that has 
elapsed since the last refresh.

6 Click Stop Statistics to stop capturing data for this employee.
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Viewing Route Status Data
The Route Statistics view displays the following for each active route:

■ The target and actual service level 

■ The average wait time, and the longest wait time

■ The total number of abandoned work items

■ The total number of work items currently in the route

NOTE: The actual service level will not display any data if no work items matched 
the route during an interval. 

To view route statistics data

1 From the application-level menu, choose View > Site Map > 
UQ Administration > Route Statistics.

The Route Statistics view appears.

2 Click Refresh to update the displayed data.
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Viewing Historical Data
Historical data that you can view includes data for work items and data for agents.

Siebel Universal Queuing maintains a journal of work items received and routed. 
The work item journal contains the following information for each work item:

■ Work item ID

■ Work item channel type

■ Work item data properties

■ Information about processing prior to delivery to an employee (one entry for 
each escalation step):

■ Routing rule ID, step number, start time, and end time

■ Information about each employee that handled this work item

■ Employee ID, start time, end time, state, user reason code

In addition, Siebel Universal Queuing creates an agent journal when an agent logs 
out. The agent journal summarizes an agent’s performance for this login session. 
The agent journal contains the following information:

■ Agent ID

■ Login time, logout time, logout reason

■ Number of times agent entered auxwork state, total auxwork time

■ Information about agent work item handling performance (one entry for each 
channel type):

■ Channel ID

■ Number of work items completed,

■ Channel work time and wrap-up time

The information contained in the work item and agent journals is the basis for the 
historical statistics described in this section. The predefined historical statistics only 
displays a subset of the available data. You can specify additional statistical 
information for custom reports by using the business objects and business 
components defined in “Business Objects and Business Components” on page 113.
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Viewing Historical Channel Statistics
The Historical Channel Statistics view displays the following for each channel:

■ The target and actual service level 

■ The average wait time, average abandon time, and the longest wait time

■ The total number of abandoned work items

■ The total number of work items for the channel

To view historical channel statistics

1 From the application-level menu, choose View > Site Map > 
UQ Administration > Historical Channel Statistics.

The Historical Channel Statistics view appears.

2 Click Enter Time Period.

3 Enter the date and time for the beginning of the period you want to view.

The date and time format is mm/dd/yyyy hh:mm:ss am.

4 Enter the for the end of the period you want to view and click OK.

The data requested is displayed in the Historical Channel Statistics view.

Viewing Historical Route Statistics
The Historical Route Statistics view displays the following for each route for a 
specified time period:

■ The target and actual service level. 

■ The average abandon time, average wait time, and the longest wait time.

■ The total number of abandoned work items.

■ The total number of work items in the queue.
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To view historical route statistics

1 From the application-level menu, choose View > Site Map > 
UQ Administration > Historical Route Statistics.

The Historical Route Statistics view appears.

2 Click Enter Time Period.

3 Enter the date and time for the beginning of the period you want to view.

The date and time format is mm/dd/yyyy hh:mm:ss am.

4 Enter the date and time for the end of the period you want to view and click OK.

The data requested is displayed in the Historical Route Statistics view.
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Business Objects and Business Components
This section describes Siebel Universal Queuing business objects and business 
components and lists the fields in each business component. This information can 
help you to access work item and agent journal data for generating custom reports.

For more information on working with business objects and business components, 
refer to Siebel Tools Reference and Siebel Tools Online Help.

Siebel Universal Queuing Business Objects
Table 11 lists the Siebel Universal Queuing business objects.

Table 11. Siebel Universal Queuing Business Objects

Business Object Description Business Components

UQ Alarms Errors Use for alarm and error messages. UQ Alarm Errors

UQ Employee Statistics Use for employee related statistics. UQ Agent Journal

UQ Agent Journal Summary

UQ Agent Media Statistics

UQ Agent Statistics

UQ Media Use to relate channel information, such as 
channel name, recoverability, service level, and 
service level percentage.

UQ Media

UQ Media Statistics Use for both real-time and historical media 
statistics.

UQ Historical Media Statistics

UQ Media Statistics(Reg)

UQ Routes Use for both real-time and historical route 
statistics.

UQ Historical Route Statistics

UQ Route Statistics(Reg)

UQ Routes

UQ Work Items Use for work item journal after completion of a 
work item.

UQ WorkItem Escalation History

UQ WorkItem Properties

UQ WorkItem State History

UQ WorkItems
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Siebel Universal Queuing Business Components
Table 12 lists the Siebel Universal Queuing business components. These business 
components are also referred to in Table 11 on page 113.

Table 12. Siebel Universal Queuing Business Components

Business Component Description / Field Field Description

UQ Agent Journal Provides data from the agent journal captured when the agent logs out. This 
data includes information about the agent—for example, how long the agent 
was logged on, how long the agent was in aux mode, how long the agent was 
in available mode, and so on.

Auxiliary Seconds Number of seconds agent was in not ready 
state.

Auxiliary States Number of times agent entered not ready 
state.

Login Time Time agent logged in.

Logout Reason Reason agent logged out.

Logout Time Time agent logged out.

User ID Agent’s user ID.
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UQ Agent Journal Summary Provides information from the agent journal for each channel on which the 
agent was working.

Agent Journal ID Foreign key to S_AGNT_JRNL table.

Auxiliary Duration Number of seconds agent was in not ready 
state.

Auxiliary States Number of times agent entered not ready 
state.

Auxiliary Duration (mins) Number of minutes agent was in not ready 
state.

Average Handle Time (mins) Average amount of time in minutes for 
each work item agent handled.

Login Time Login time of the agent.

Logout Reason Logout reason.

Logout Time Logout time of the agent.

Media Type Channel type.

Media Type ID Foreign key to S_CM_MEDIA table.

Served Work Items Total number of work items served.

User ID Foreign key to S_CONTACT table.

Work Minutes Time the agent actually worked on this 
channel, in minutes.

Work Seconds Time the agent actually worked on this 
channel, in seconds.

Wrap Minutes Time the user wraps this channel in 
minutes.

Wrap Seconds Time the user wraps this channel in 
seconds. 

Table 12. Siebel Universal Queuing Business Components

Business Component Description / Field Field Description
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UQ Agent Media Statistics Provides channel information for Agent Statistics business component. Child 
of UQ Agent Statistics.

Agent Statistics ID Foreign key to S_AGNT_JRNL table.

Auxiliary Seconds Number of seconds agent was in not ready 
state for this channel.

Auxiliary States Number of times agent entered not ready 
state for this channel.

Auxiliary Time (mins) Number of minutes agent was in not ready 
state for this channel.

End Time Logout time of the agent.

Media Type Channel type.

Media Type ID Foreign key to S_CM_MEDIA table.

Served Work Items Total number of work items served.

Start Time Login time of the agent.

Time Interval

User ID Foreign key to S_CONTACT table.

Work Minutes Time agent actually worked on this 
channel.

Work Seconds Time the agent actually worked on this 
channel.

Wrap Minutes Time the agent wraps this channel in 
minutes.

Wrap Seconds Time the agent wraps this channel in 
seconds.

Table 12. Siebel Universal Queuing Business Components

Business Component Description / Field Field Description
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UQ Agent Statistics Information provided by UQ HandleAgentStatistics. This is a real-time 
feeding of agent information and agent channel information. UQ Agent 
Media Statistics is a related business component.

Auxiliary Seconds

Auxiliary States

End Time

Start Time

User ID Foreign key to S_CONTACT table.

UQ Alarms Errors Shows all the alarms and errors.

Code Error or alarm message code.

Message Message description.

Name Important information regarding the alarm 
or error, in the form of comma-delimited 
key-value pairs.

The maximum text length for this field is 
50.

Severity Severity of alarm.

Start Time

Type

Table 12. Siebel Universal Queuing Business Components

Business Component Description / Field Field Description
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UQ Media Shows all channel configurations including channel name, service level, and 
whether or not this channel type is failure-recoverable. Used together with 
UQ Media Statistics(Reg).

Current Current

Interactive After a system failure, work items of 
interactive type (for example, voice calls) 
do not need to be recovered when the 
system is restarted.

Media Type Channel type.

Raw Target Service Level Service level in seconds.

Service Level Percentage Service level in percentage.

Start Time The time when the record is created.

Target Service Level Service level in seconds.

UQ Media Statistics(Reg) Contains channel real-time statistics information.

Abandoned

Assigned Work Items

Average Wait Time

Comments

Delivered Work Items

End Time

Longest Wait Time

Media Type

Service Level Set

Service Level Workitems

Start Time

WorkItems

Table 12. Siebel Universal Queuing Business Components

Business Component Description / Field Field Description
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UQ Route Statistics(Reg) Shows all the routing statistics.

Abandon

Assigned WorkItems

Average Handle Time

Average Wait Time

Comments

Delivered WorkItems

End Time

Longest Wait Time

Name

Service Level Set

Service Level WorkItems

Start Time

UQ Route ID

WorkItems

Table 12. Siebel Universal Queuing Business Components

Business Component Description / Field Field Description
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UQ Routes Shows routes information. This information is used in UQ Route 
Statistics(Reg).

Capacity

Media Type

Name

Non Real-Time

Priority

Raw Target Service Level

Service Level Percentage

Target Service Level

UQ WorkItem Escalation History Provides the escalation history of a work item.

Escalation End Time

Escalation Result

Escalation Start Time

Escalation Step Name

UQ Route Name

Work Item ID

UQ WorkItem Properties Provides the data properties for a work item.

Name

Value

Work Item ID

Table 12. Siebel Universal Queuing Business Components

Business Component Description / Field Field Description
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UQ WorkItem State History Provides the state history of a work item. For example, all the agents that 
worked on this work item.

Agent End Time

Agent Reason

Agent Start Time

Agent State

UQ Reason

User ID Foreign key to S_CONTACT table.

Work Item ID Foreign key to S_UQ_WORK_ITEM table.

UQ WorkItems The master work item. Each completed work item has an entry in this 
business component.

End Time

Media Type

Media Type ID

Row ID

Start Time

Work Item Name

Table 12. Siebel Universal Queuing Business Components

Business Component Description / Field Field Description
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Interfacing with Siebel Universal Queuing 5
This chapter describes how to use the Universal Queuing business service to access 
functions in Siebel Universal Queuing.

Business services represent functionality that is encapsulated in a named service, 
for which methods can be called by the Siebel application. Many types of Siebel 
eBusiness Applications functionality, including Universal Queuing functionality, 
can be accessed as methods of Siebel-provided business services.

For more information about working with Siebel business services, refer to:

■ Siebel Communications Server Administration Guide

■ Siebel Business Process Designer Administration Guide

■ Siebel Tools Reference

■ Siebel Tools Online Help
Version 7.5 Siebel Universal Queuing Administration Guide 123



Interfacing with Siebel Universal Queuing

Business Service Methods
Business Service Methods
This section describes the Siebel Universal Queueing business service methods 
available to interface with the Siebel Universal Queuing routing engine, and 
documents the return codes for these methods. The name of the business service is 
Universal Queuing. The methods are:

■ AddWorkItem on page 124

■ CompleteWorkItem on page 126

■ RequestAgentState on page 127

■ RequestWorkItemState on page 128

AddWorkItem
Table 13 lists the arguments for the AddWorkItem method. This method adds the 
specified work item into Siebel Universal Queuing for routing.

Table 13. AddWorkItem Method Arguments

Argument Name Display Name Type Required Comment

WorkItemID WorkItemID Input Y The work item ID for the work item 
being added.

MediaType MediaType Input Y The channel type (such as voice, 
email, fax, and so on).

IsInteractive IsInteractive Input Y TRUE or FALSE.

IsScheduledTask IsScheduledTask Input N TRUE or FALSE. TRUE indicates 
this work item is scheduled to be 
routed during a particular time 
frame as specified in 
ScheduleStartTime and 
ScheduleEndTime. The work item 
will not be evaluated until at least 
the ScheduleStartTime.

ScheduleStartTime ScheduleStartTime Input N UTC time. Integer value in ASCII.

ScheduleEndTime ScheduleEndTime Input N UTC time. Integer value in ASCII.
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A data property set describes the work item. WorkItemDataProperty is a key-value 
pair data property that carries information to describe the work item itself. For 
example, an email work item data property could have the following:

Recipient = sales@company.com
Subject = NT
From = user@siebel.com

Normally, when an agent is assigned to a work item, the work item will be sent 
directly to an agent. If for any reason the work item is not to be routed to an agent, 
the SiebelLoginID and ClientKey is included in the work item data property. 

When the routing engine detects these two pieces of information in the work item 
data property, the work item will be routed to the destination specified by 
SiebelLoginID and ClientKey using Server Request Broker key-based routing.

IsScheduledTask, ScheduleStartTime, and ScheduleEndTime are optional 
arguments that are used when the work item needs to be performed during a 
specified time period.

WorkItemDataProperty WorkItemDataProperty Input N Other information in name and 
value pairs. This data property is a 
child data property set.

Return Return Output Y One of the return codes given in 
Table 17 on page 129.

Table 13. AddWorkItem Method Arguments

Argument Name Display Name Type Required Comment
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CompleteWorkItem
Table 14 lists the arguments for the CompleteWorkItem method. This method tells 
Siebel Universal Queuing that the work item is completed. The next state for the 
agent will depend on the Auto-Wrap setting. If TRUE, both the agent and the work 
item will be in wrap mode. If FALSE, the agent returns to the ready state.

Table 14. CompleteWorkItem Method Arguments

Argument Name Display Name Type Required Comment

AgentLogin AgentLogin Input Y AgentID of the logged in agent. Used to dispatch work 
items to an agent. 

WorkItemID WorkItemID Input Y The work item ID for the item the agent wants to 
complete.

Return Return Output Y One of the return codes given in Table 17 on page 129.
126 Siebel Universal Queuing Administration Guide Version 7.5



Interfacing with Siebel Universal Queuing

Business Service Methods
RequestAgentState
Table 15 lists the arguments for the RequestAgentState method. This method 
requests the routing engine to report the current agent state for the specified agent.

Table 15. RequestAgentState Method Arguments

Argument Name Display Name Type Required Comment

AgentLogin AgentLogin Input Y AgentID of the logged in agent. Used to dispatch work 
items to an agent. 

AgentState AgentState Output Y One of the possible agent states:

SUQ_AS_AUXWORK – Agent is in not ready state. 
Agent has no active work items and the routing engine 
will not dispatch work items to agent.

SUQ_AS_AVAILABLE – Agent is ready to receive new 
work item but currently has no work items.

SUQ_AS_BUSY – Agent is busy on one or more work 
items.

SUQ_AS_INITAUXWORK – Initiating not ready mode. 
After all the work items are complete, the routing 
engine puts the agent in the not ready state.

SUQ_AS_LOGGEDIN – Initial state when agent has just 
logged in and is not in an available state.

SUQ_AS_LOGOUT – Agent is logged out.

SUQ_AS_PICMODEAVAILABLE – Intermediate state 
between not ready and pick mode working states.

SUQ_AS_PICMODEWORKING – Agent is working on a 
work item selected from My Qualified Work Items list.

Return Return Output Y One of the return codes given in Table 17 on page 129.
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Table 16 lists the arguments for the RequestWorkItemState method. This method 
requests the current state of the specified work item.

Table 16. RequestWorkItemState Method Arguments

Argument Name Display Name Type Required Comment

WorkItemID WorkItemID Input Y The work item ID for which state is being requested.

WorkItemState WorkItemState Output Y One of the possible work item states:

SUQ_WIS_ACTIVE – Work item is accepted by 
agent.

SUQ_WIS_ALERTING – Work item is assigned to an 
agent but agent has not yet accepted work item.

SUQ_WIS_COMPLETED – Work item is completed 
and ready to be removed from system.

SUQ_WIS_ON_HOLD – Work item is suspended. For 
example, a call that is put on hold.

SUQ_WIS_QUEUED – Work item is matched to a 
route and waiting for assignment to an agent.

SUQ_WIS_RECEIVED – Work item was received by 
the routing engine but not yet matched to a route.

SUQ_WIS_SCHEDULED – Work item is scheduled to 
be assigned later.

SUQ_WIS_TXALERTING – Work item is in transfer 
alerting state. For example, agent 1 is transferring 
work item to agent 2 and has notified agent 2. For 
real-time work items only.

SUQ_WIS_TXCONNECT – Work item is transferred 
to new agent. 

SUQ_WIS_TXDISCONNECT – Work item is 
suspended. For example, agent 1 is disconnected 
from agent 2 and agent 1 has not yet started working 
on work item again.

SUQ_WIS_WRAP_UP – Work item is accepted by 
agent, completed, and agent is in wrap up state.

Return Return Output Y One of the return codes given in Table 17 on 
page 129.
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Return Codes for Business Service Methods
Table 17 gives the possible return codes for the Siebel Universal Queuing business 
service methods discussed in this chapter. Only the numeric value is returned.

Table 17. Business Service Return Codes

Return Code Value

SUQ_SUCCESS 0

UQ_ERR_CONNECTION_NOT_FOUND 6

UQ_ERR_AGENT_NOT_FOUND 7

UQ_ERR_AGENT_BUSY 11

UQ_ERR_AGENT_STATE_NOT_VALID 12

UQ_ERR_AGENT_NOT_AVAILABLE 13

UQ_ERR_WORKITEM_NOT_FOUND 17

UQ_ERR_NOT_PRIMARY_UQ 30

 UQ_ERR_WRONG_WORKITEM 51
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Troubleshooting Siebel Universal Queuing 6
This chapter provides troubleshooting information for problems you may encounter 
while running the Siebel Universal Queuing routing engine.
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Installation Issues
Table 18 gives a solution to an installation-related problem.

Table 18. Installation Issues

Symptom Reason Solution

No choices are available on the 
Database Configuration dialog box 
during installation on Microsoft 
Windows NT or Microsoft 
Windows 2000.

Database client is not installed. Install the client tools for the 
appropriate database (Microsoft 
SQL Server, IBM DB2, or Oracle) to 
which you will be connecting.
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Network Issues
Table 19 gives solutions to network-related problems.

Table 19. Network Issues

Symptom Reason Solution

Unable to communicate 
with Siebel Universal 
Queuing.

The machine where Siebel Universal 
Queuing is installed may not be 
accessible on the network.

Ping the machine by its name and by 
its IP address. If the machine does not 
respond to the ping, contact network 
administrators.

The UQ connector process may not be 
running on the Siebel Universal 
Queuing machine.

Use netstat to check if the port (set 
during installation) is already in use. If 
the port is in use, try the following 
steps:

■ Reinstall the product with a port 
that is not in use.

■ Check if ORB servers (qntorbsvr, 
dssrv, armsrv, alertsrv) are 
running. If not, contact support.

■ Check if correct database instance 
was set during installation.
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Unable to send events to 
EAI Object Manager.

The machine where EAI Object 
Manager is installed may not be 
accessible.

Ping the machine by its name and by 
its IP address. If the machine does not 
respond to the ping, contact network 
administrators.

EAI Object Manager itself may not be 
running.

Try starting the server.

Siebel Communications Server may 
not have sent valid configuration 
information for setting up connection 
with EAI Object Manager.

Make sure Siebel Communications 
Server is sending valid configuration 
information (for example, IP address, 
port, username or password) to Siebel 
Universal Queuing. 

Check Siebel Universal Queuing 
configuration for valid information.

UQ connector process may not be 
running on the Siebel Universal 
Queuing machine.

Use netstat to check if the port (set 
during installation) is already in use. If 
the port is in use, try the following 
steps:

■ Reinstall the product with a port 
that is not in use.

■ Check if ORB servers (qntorbsvr, 
dssrv, armsrv, alertsrv) are 
running. If not, contact support.

■ Check if correct database instance 
was set during installation.

Web server is not receiving 
stat events.

Secondary connection may not be set 
up.

Make sure Siebel Communications 
Server has set up secondary 
connection for statistics.

Configuration information sent may 
be wrong.

Make sure Siebel Communications 
Server is sending valid configuration 
information (for example, IP address, 
port, username or password) for the 
secondary connection to Siebel 
Universal Queuing.

Check Siebel Universal Queuing 
configuration for valid information.

Table 19. Network Issues

Symptom Reason Solution
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Table 20 gives a solution to an application-related problem.

Table 20. Application Issues

Symptom Reason Solution

SOAP requests related to agents 
and work items sent to Siebel 
Universal Queuing are failing.

One or more required servers 
(qatdsrv, adusrv, vdusr, dustore) 
may not be running.

Check if these processes are 
running. If not, collect log files 
and send to support for further 
investigation.
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